Project: Computer based Braille System in Indian Languages ("e-Braille")

Documentation Supported by:-
Department of Academic Reforms & Public Grievances
Ministry of Personnel, Public Grievances & Pensions
Government of India

Webel Mediatronics Limited
(A Govt. of West Bengal Undertaking)
P-1, Taratala Road, Kolkata – 700088
Acknowledgement

We express our gratitude to the Department of Information Technology, Ministry of Communications and Information Technology for awarding us the projects and giving us continuous support and guidance. Dr. U. P. Phadke, Advisor, Mr. S. R. Das, Sr Director, Dr. K. S. K. Sai, Sr. Director, Mr. B. S. Bedi, Sr. Director, and Mr. K. K. Ghosh, Director have always been a source of inspiration for us.

We are thankful to Prof A Basu, Indian Institute of Technology, Kharagpur for initial valuable support in software development and Prof. B. B. Chaudhury, Indian Statistical Institute, Kolkata for his valuable contribution in software development.

We are thankful to National institute of Visually Handicapped, Dehradun, National Association of the Blind, Mumbai, blind Relief Association, New Delhi for their valuable inputs and encouragement in implementing the project.

We are indebted to Late M. K. Chaudhury, Late Ashok Chaudhury, Ex-principal Calcutta Blind School, Mr. Dilip Loyalka, NAB, Kolkata, Swami Viswanathananda, Vivekananda Mission Asram, Chaitanyapur, Mr. Parameswar Sengupta, Narendrapur Ramkrishna Mission, Kolkata, Mr. Virendra Singh, NIVH, Dehradun, Mr. Ketan Kothari, Ex-NAB, Mumbai. We are also thankful to Mr. G. Kumarappa, National Library, Kolkata for helping us with Indian languages.

We are also expressing our gratitude to all those institutes and individuals we have taken support from in our way of proceeding with the project.
Content

1. Introduction

2. Objective

3. Achievements

4. Implementation

5. Annexure – A (Technical Details)

6. Annexure – B (List of all schools covered under various projects)

7. Annexure – C (Books available in www.braille-aids.in)

8. Annexure – D (Manuals of Braille Products)

9. Annexure – E (Outcome of the Projects)
1. Introduction

Background

In the recent years, there has been a major shift in the way technology is shaping our lives. The digital revolution has changed the way we communicate, work, entertain and educate. The World Wide Web has opened up the resource of unlimited, inexhaustible information; an array of user-friendly software helps us to tackle our daily office core, and digital communication in the buzzword.

To erase the digital divide it becomes necessary to make technology available to one and all, which means to provide solutions for a range of users who may not be the regular cyber whiz kid next door. They may be individuals with disabilities for whom the boon of information technology yet stand still.

Nations have already felt the need of providing accessible contents and developing accessible technologies for the disabled, which has led to the establishment of new government policies across the globe. Parallel to their peers, the Department of Information Technology, MCIT, Government of India, in April 2000, launched the Jaivigyan Project, Information Technology for Braille Literacy in Indian Languages. The challenging task of development of technologies and building infrastructure under Jaivigyan program of Govt. of India was bestowed upon Webel Mediatronics Limited, A Government of West Bengal Undertaking Unit.

Webel Mediatronics Limited has a Research and Development Unit approved by the Department of Science and Industrial Research (DSIR). WML had already developed and Automatic Braille Embosser, WIMATS, Tactile Reader etc. WML received National Awards for the above development work.
There are approximately 9 million people with visual impairment in India, among which only a meager 3% (as per census of 1981) is literate. There are 309 Govt. aided schools for the visually impaired, which can accommodate just 30,000 students! There has been a dearth of books in Braille in regional languages, as the manual replication process is a tedious job. The process of writing word by word on hard paper using Braille Slate and Stylus is time consuming, strenuous and prone to human error. For making copies of same document the task becomes repetitive with repeated chances of human error. Obvious condition of the process is that the writer has to be equipped with knowledge of Braille.

The people with visual impairment use Braille script as an alternative for written script. The famous Louis Braille, a Frenchman, who was blinded at the age of four, founded Braille script. The Braille script uses six dots arranged on a grid to form maximum 63 characters, which represent the various letters, punctuation marks and special markers of any language.
2. Objective

During inception, the foremost objective of the project was to support primary education and extend literacy by making available adequate Braille resources to the visually impaired students of the country-employing computer based Braille Transcription System in Indian languages.

Another important objective was to empower the visually impaired with software applications and assistive devices which will enable them to use computers and work in a regular computerized office environment.

The comprehensive effort of Webel Mediatronics Limited tried to address many of the activities of an educational environment for the visually impaired, namely reading, writing, teaching, learning, printing, etc.

The Braille material being bulky, expensive and difficult to store, the library for the blind is not common. The storage of documents and consequent automatic transcription in Braille form, with the facility of reading through Tactile Braille Reader and printing as and when required will address to these problems.

The printed Braille material is also very difficult to transport. Networking of different institutions and sharing of Braille material over the network will work out to be most efficient and economical.

The realization of the above scheme calls for following:

1. Development of an educational infrastructure for the visually impaired, incorporating applications of computer and information technology. This will also be an enabling technology for the existing Braille education organizations, facilitating rapid development and dissemination of educational material & information.

2. To develop technology base (required hardware, software and Information system platforms) for dissemination of educational material & information in Indian languages through transliteration in Braille.

3. Development of Electronic Library for maintaining a repository of reading material including newspapers/magazines etc.

4. Establishment of Resource Centers (RC) and Training Centers (TC) for this purpose.

5. Networking of such RCs and TCs.

6. Imparting trainings (and development of training material) to the visually impaired to use the new technology.
3. Achievements

System Diagram

Project: IT for Braille Literacy in Indian Language

COMPUTERISED BRAILLE TRANSCRIPTION SYSTEM

SOFTWARE

- Print Through
- Mail to Braille
- BrailleWriter
- BrailleSystem
- Text to Braille

INPUT DEVICES

- Braille Keyboard (BK5-10)
- Parallel operation 8 lines
- Normal Qwerty Keyboard
- EasyBraille

OUTPUT DEVICES

- Tactile Reader
- Parallel operation 8 lines
- Braille Embosser
- Index & Perkins
- Parallel Operations

Networking
Above figure is the system diagram of the Computerised Braille Transcription System designed, developed and implemented in 190 schools for the visually impaired throughout India.

The Computerised Braille Transcription System installed at the blind schools are being used for the first time for printing text books, question papers, class notes, notices etc. facilitating a qualitative change in Braille education.

In order to facilitate literacy and education among visually impaired persons, under the project, an IT enabled Braille education infrastructure has been implemented. The infrastructure is aimed to accelerate teaching, reading, learning and printing in an internetworked and integrated environment.

The system covers transcription in 12 Indian languages such as Bangla, Hindi, Assamese, Oriya, Marathi, Gujarati, Punjabi, Tamil, Telugu, Kannada, Malayalam, Nepali and English.

Braille-ready texts are available in all the above Indian languages at www.braille-aids.in. A country-wide electronic Braille library is now a possibility using computers, internet and the Tactile Readers.

Software

1. **BrailleToText**  
   Software for Braille to Text conversion using normal computer keyboard in 13 Indian Languages has been done. Also interface to most of the imported Braille embossers available in India done.

2. **TextToBraille**  
   Software for Text to Braille conversion in 13 Indian Languages has been done. Also interface to most of the imported Braille embossers available in India done.

3. **MathBraille**  
   Software for conversion of mathematics books in English Language to Braille script and printing the same using Braille.

4. **Teaching & Learning**  
   Software for self-teaching of Bharati Braille, useful for teachers and instructors of the blind schools.

4. **BrailleExam**  
   Software for self evaluation of the visually impaired students, useful for teachers and instructors of the blind schools.
5. **E-Reading**
   Interface for reading of Indian language text documents using Tactile Devices and also interface to read Braille documents from imported Transcription software using tactile Devices.

6. **Braille Writer**
   Software for Braille to Text conversion using Braille Keyboard in 13 Indian Languages has been done where as in the original scope it was for English only. Also interface to most of the imported Braille embossers available in India.

7. **Software for formatting Braille document as done in MS-WORD and iLeap.**

8. **Software for reading & printing Braille document created by Duxbury software using out Tactile device and Perkins's brailler respectively.**

9. **Upgradation of the Braille to Text software Direct Braille with continuous speech support in Bengali and it will be available in other languages also as soon as the TTS is available.**

10. **TalkingDictionary**
   Software for Talking Braille Dictionary in Bengali, useful for the visually impaired students of the blind schools as well as all other users.

11. **English Grade II Transcription Software**
    Software for Text to Braille conversion in Grd II English is available with interface to most of the imported Braille embossers available in India.

**Hardware**

1. **Modified Perkins Brailler**
   Modified Perkins Brailler is basically a Perkins Brailler modified suitably by Webel Mediatronics Ltd to communicate with Computers and emboss automatically. The Embossor has been automated for paper feed and carriage motion and can also print in interline mode for both side Braille printing.

2. **Braille Keyboard**
   It is an indigenously designed and developed computer keyboard for the visually impaired persons. Braille keyboard (BKB-10) provides user friendly computerized environment for Braille file handling, Braille to Text conversion, Braille embossing as well as ink printing option by visually challenged person. Audio feedback enables visually impaired user to run the software independently.

   A classroom can be made interactive by the use of Braille keyboard with audio support and software. Each individual student in the classroom can be given a Braille keyboard (4 Braille Keyboards can be connected with a single workstation) and while writing the students using Braille keyboard, the teacher can monitor activity of each student at a glance on a single monitor. Thus monitoring the performance in a test has been made easier using gadget.
3. Tactile Reader

Braille paper is costly, longevity of Braille books is limited and they are bulky. To overcome these difficulties, Webel Mediatronics Limited has developed a paperless reading system consisting of electronic Tactile Reader and Read-Braille Software.

The device has refreshable Braille display of 20 characters in one line and a few control keys so that visually impaired persons can read a Braille file/book/document from a PC at his own speed. The control keys allow him to go to Next Line / Previous Line, Next Block / Previous Block, Start / End of Book etc.

Study Materials

In order to give a thrust to the post development phase on receipt of repeated requests from various visually impaired schools for generation of Electronic repository in various languages using the newly developed Transcription software, a setup using few high speed printers at WML was made for large volume data entry and printing. The effort produced result and a large repository of books in Braille ready format could be created starting from almost void.

School level books completed in different languages

1. Bengali- all books as per the syllabus of West Bengal Board from Class I to Class XII
2. Tamil- text books on Tamil Language, Science, Mathematics for Class VI to Class XI
3. Kannada- text books on Kannada Language, mathematics, music notations up to class VII
4. Telugu- text books on Telugu Language, social science, science up to class VII
5. Gujarati- text books on Gujarati Language, politics, Computer up to class VI
6. Hindi- text books on Hindi Language, mathematics
7. English- text books on English Language from different boards
8. Malayalam- text books on Malayalam Language, Science, Social science, History for Class I to Class X
9. Manipuri- text books on Manipuri Language
Now the important objective of filling the gap in availability of Braille material is within sight and the software as well as the repository is ready for use by any institution and individual.

www.braille-aids.in

WML has hosted www.braille-aids.in, a user group website for the visually challenged, as well as concerned organizations and individual, which provides with a broad overview of the project.

This website maintains an online Braille Resource Archive in Indian languages, from where Braille texts can be downloaded; also Creative Writing section and online Audio Station for the visually challenged.

This website is intended to be used as an information exchange platform for the various visually impaired schools.

4. Implementation

The Computerised Braille Transcription System as shown in the System Diagram has been installed in 190 visually impaired schools throughout the country under different projects.

The role of this IT enabled Braille education centers are:

1. Offering Braille Transcription and resource development facility locally at respective regional languages:
   The computerized local Braille presses of the institutes are engaged in Development of Braille books and meeting the requirements locally. Class Notes, Question Papers, Handouts and other such documents are being printed promptly in Braille on demand basis.
2. Offering E-Library which is a computer enabled Interactive reading room where the visually impaired individuals are able to read text of their from the electronic repository of reading materials. An E-Library has the following main functions:
   a. Maintaining a setup of multiple reading desks (at most 4 no. at a time) equipped with Tactile Readers.
   b. Maintaining an administrator/Librarian's Terminal for monitoring, feeding text, connecting / disconnecting of Tactile Readers.
   c. Maintaining an archive of Braille ready Texts for. Text books of Primary, Secondary, Higher Secondary levels and extra curricular reading material e.g. literature, science & technology, sports & games etc.
2. Offering E-Class Room which is a computer enabled Interactive class room where teacher-student interaction, preparation of study material & recording of progress, conducting tests for students etc. have been automated. An E-Class Room has

a. A facility of an array of at most 4 no. Students' desks having one Braille Key Board (with voice support) each connected to Teachers Computer through Cable.

b. A teachers terminal is loaded with software for monitoring data entry by Students, Voice Communication to Students, Setting up of study materials, question sets, recording of answer scripts etc and also Recording of Students attendance, proceedings of classes, progress reports etc. along with facility for text printouts.

![Diagram of E-Classroom setup]
The transcription system installed at the blind schools are being used for the first time for printing text books, question papers, class notes, notices etc. facilitating a qualitative change in Braille education.

The system covers transcription in 13 Indian languages such as Bangla, Hindi, Assamese, Oriya, Marathi, Gujarati, Punjabi, Tamil, Telugu, Kannada, Malayalam, Nepali, Manipuri and English.

190 visually schools throughout the country attached to it.

**Resource Center & Training Center Networking**

Simultaneous to technology development and implementation of IT empowered educational infrastructure at blind institutes across the regions, a key task was to interconnect the resource centers and training centers for building up a centralized pool of Braille resources in Indian languages and English which visually impaired students can use for education.

The objectives of interconnecting the Resource Centers and Training Centers are to:

1. Building up a countrywide Central Storage Archive of electronic Braille resources in 13 Indian languages and English created by 5 Resource Centers and 25 Training Centers
2. Facilitating fast accessing of Braille material by all institutes and individuals
3. Mutual sharing of the Braille resource among the Resource and Training Centers
4. Publishing a catalog mentioning which book is available with which Center so that a more systematic Braille material availing by the institutes and individuals could be ensured.
Interconnecting Resource Center & Training Center

- Creating Electronic Braille Files in English and respective regional languages
- Uploading them in the Braille Resource Archive of www.braille-aids.com
- Allowing students and member to download files from the Resource Archive and Print if required
- Allowing students and members search the database

Other Blind Institutes Equipped with Computerized Braille Systems

- SEARCHING for a specific book
- Downloading required Braille books in Electronic Format from Braille Resource Archive of www.braille-aids.com
- Printing and distributing to the students
12 years from the first step that was taken, Webel Mediatronics Limited has come a long way, to be able to contribute in developing accessible technologies for the people with visual handicap.

More than 500 teachers from across the country have already been trained in using the software and hardware. Blind schools can now print question papers, textbooks and literacy classics for their day-to-day use.

A person with visual impairment has to face limitation in mobility, communication, employment and acquiring information. This limitations result in growing up with a poor self image which limits making most out of one’s life. Assistive devices, to aid in physical limitations and facilitate education are therefore utmost essential for an individual with impairment to grow up as a confident human being with enhanced self-image who can positively contribute to the society. Software and assistive gadgets can make significant impact in the life of a person with visual impairment this way.
Annexure A: Technical Details
Text-to-Braille
Text-to-Braille Transcription Software in Indian Languages

- Windows based Text to Braille Transcription software in twelve Indian languages including English.
- Text-to-Braille conversion as per Bharati Braille standard.
- Supports printing through Automatic Braille embosser (BPRT-10)
- Interfaces available for Index Interpoint and Braille 400 embossers. Customisation for other brailers undertaken on request.
- Operation requires on prior knowledge of Braille.

WEBEL MEDIATRONICS LIMITED
P-1, Taratala Road, Kolkata – 700 088

Phone: 91 – 33 – 2481 3699/5602/ 0712
Fax: 91 – 33 – 2481 4681
E-mail: webelmia@gmail.com
Visit us at: www.braille-aids.in
Text-to-Braille

Salient Features

- The Software is menu driven and user friendly.
- It has a self explanatory GUI, and can be operated by any computer user with/without minimum knowledge of Braille.
- The software converts the text files entered through I-leaf software and MS-WORD into the corresponding Braille instantly.
- The transcribed Braille file can be previewed in the screen along with the text maintaining a correlation between the two, which makes the system more user friendly.
- The transcribed Braille file can be saved in the hard disk in Braille format (support saving DUXBURY FORMAT) and can be edited whenever required.
- The Braille files (support saving DUXBURY FORMAT) can be opened bypassing the text file. So if the transcribed file is once generated can be printed/viewed that makes the operation easier.
- Supports both Normal and Expanded Preview and Braille Printing in expanded mode only.
- Print Format i.e. Number of lines per page and number of characters per Line can be programmed by the user before transcription.
- The downloaded English file and any e-mail document can be embossed using this software.
- Supports interfacing to most of the imported Braille embossers available in India.
- Supports GRD II transcription of English document.
DirectBraille
Braille-to-Text Transcription Software in Indian Languages

Rehabilitation Tool
Communication Tool
Education Tool

- Windows based audio enhanced software for
  Braille-to-Text transcription in 12 Indian
  languages, and English.

- Suitable for visually impaired users working
  in regular office environment for unassisted
  PC operation.

- Printing in Braille as well as test by the
  visually impaired.

Developed with Technical Advice from
Prof. B. B. Chowdhury, Indian Statistical Institute, Kolkata

WEBEL MEDIATRONICS LIMITED
P-1, Tanatala Road, Kolkata – 700 088

Phone: 91 – 33 – 2401 7699/5600/ 0712
Fax: 91 – 33 – 2401 4681
E-mail: webelmedia@gmail.com
Visit us at: www.braille-uds.in
DirectBraille

Salient Features

- The visually impaired person can operate the computer independently for data entry in Braille. No extra hardware is required for Braille entry.

- QWERTY keyboard is used for data entry. When the software is not in use, remove the musk cover, it becomes a normal keyboard.

- The typed Braille is converted to text, which can be viewed & printed using iLEAP software of ODAG or MS-WORD (for English data). A visually impaired person can take both text & Braille print out independently.

- Braille, once typed, can also be printed using Braille embosser. Multiple print out can be taken whenever required. A visually handicapped person can operate the embosser.

- Since both the Braille print & ink print can be taken, the system facilitates visually impaired persons working in an office environment of sighted persons.

- Braille-to-Braille module has been developed where the visually impaired persons can enter any Braille code in any language (English grade2 mathematics book).

- In different blind organization, visually impaired students can type their necessary class note, deliver the class tests in a computerized environment, which is necessary to build the self-confidence among them.
EasyBraille
Teach Yourself Braille

- Multimedia based interactive CD-ROM
- Developed for would be teachers and transcribers.
- Self-testing facility at various stages.
- Available in twelve Indian languages including English.
- Suitable for Teachers’ Training Programmes by Braille Training Institutes.

WEBEL MEDIATRONICS LIMITED
P.O. Tatasala Road, Kolkata – 700 068
Easy Braille

Salient Features

• Teach Yourself Braille – an interactive multimedia based CD-ROM for learning Braille in Indian languages for sighted persons.

• Covers from simple alphabets to complex contraction rules in lucid language enhanced by audio.

• Comprehensive self-test facility at various stages.

• Based on standard rulebooks followed in Indian and abroad.

• Languages covered are English, Hindi, Bengali, Oriya, Tamil, Telugu, Kannda, Malayalam, Punjabi, Assamese and Marathi.
BrailleWriter &
BrailleKeyboard (BKB-10)

- An ergonomically designed keyboard with audio support for Braille entry by the visually impaired.
- Eight Braille Key Boards can be connected to one PC and operated simultaneously under multi-user environment.
- Braille and text printing by the visually handicapped.
- Suitable for classroom environment.
Braille Writer

**Salient Features**

- State of the art Windows based Software.
- Support operation up to eight Braille Keyboard terminals in parallel simultaneously.
- Allows direct entry in Braille codes, with audio support.
- Braille and Text printing by the blind.
- Braille to Text conversion in English & Indian Languages.
- Only eighteen keys for full-scale operation.

Braille Keyboard

**Salient Features**

- Keyboard connected to Serial Port.
- Allows direct entry in Braille codes.
- Eight dedicated Braille Keyboards can be connected to one PC and operated simultaneously.
- Only eighteen keys ergonomically arranged which are most convenient for the visually handicapped users.
- User-friendly audio support for every key pressed.
- Light weight: 1 KG (approx.)
- Micro controller based design.
- Baud rate: 4.8 Kbps.
- Built in serial interface to computer.
- Built in speaker, Provision for headphone.
- Built in microphone.
- Battery back up for storing audio.
- Supply voltage: 230V AC, 50 Hz.
- Power consumption: less than 500 m Watt.
Automatic Braille Embosser

- Mechanical Perkins Braille converted to electronic Braille with indigenously developed micro controller based electronic kit.
- Four Embossers can be connected to the same computer and parallel printing can be done for fast replication.
- Printing from Direct Braille, Text-To-Braille and Math Braille software to meet day-to-day need of Braille material.
- Received National Award in the year 2000 from Ministry of Social Justice and empowerment, Govt. of India.
**Automatic Braille Embosser**

**Salient Features**

- PC driven Automatic Braille Embosser.
- Automatic Paper loading, release etc.
- Self-diagnosis at various stages of operation.
- Suitable for effective local presses — e.g. Blind Institution/NGOs/Libraries.
- Support Text-to-Braille, Braille-To-Text and Math Braille Software etc. developed by Webel Mediatronics Limited.

**Technical Specification:**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Paper loading, Testing and Printing (2 modes)</td>
</tr>
<tr>
<td>Speed</td>
<td>8 Characters per second.</td>
</tr>
<tr>
<td>Print format</td>
<td>30 lines/page; &amp; 36 (Programmable)</td>
</tr>
<tr>
<td>Character per line, Left Margin set</td>
<td>Automatic.</td>
</tr>
<tr>
<td>Line &amp; Paper feed</td>
<td>Stepper motor driven.</td>
</tr>
<tr>
<td>Parallel operation</td>
<td>Upto 4 printers.</td>
</tr>
<tr>
<td>Power</td>
<td>230V, 50 Hz 1 ph AC,</td>
</tr>
<tr>
<td>200 Watts (app.)</td>
<td></td>
</tr>
<tr>
<td>Accessories</td>
<td>RS232 Cable – 1 mtr.</td>
</tr>
<tr>
<td>Power Cable</td>
<td>2 Mtrs.</td>
</tr>
</tbody>
</table>
Tact-Braille

- PC based Tactile Device for paperless reading.
- Single line 20 characters Braille display.
- Micro-controller based state-of-the-art design.
- Ten users can have access to the same file from a single PC.
- Set up paperless reading room for the visually impaired.
- Text available in different computers can be accessed through network.

WEBFL MEDATRONICS LIMITED
P-1, Tansah Road, Kolkata – 700 088
Phone: 91 – 33 – 2401 3699/6602/ 9712
Fax 91 – 33 – 2401 4081
E-mail: webtechmed@ymcal.com
Visit us at: www.braille-aids.in
Tactile Reader

Salient Features

Tactile Reader is a Tactile Device and an alternative to paper prints of Braille material.

This PC based touch reading device can be used to read line by line any Braille matter stored into a PC in form of electronic text file.

The device offers a set of control switches like start, stop, exit line, previous line etc. for reading operation.

Upto 8 units can be connected in parallel for supporting different users simultaneously from a single PC.

Developed with interface software to support English and Indian Languages.

Technical Specification:

- Power Adapter
  Input: 160 to 230 V AC at 50 Hz.
  Output: 12V DC

- Number of Braille Characters: 20

- Power Input: 12V DC through jack on the rear panel.

- Serial communication: Inlet through 9 Pin D connector male.

- Audio through earphone jack on the front panel (23 mW)

- Green Led for Power indication.

- RX/TX Bicolor Led indication for receiving / transmitting data.
MathBraille
Software for publishing Mathematics and Science books in Braille

- Windows based software for Braille transcription of Mathematics and Science texts in 12 Indian languages including English.
- Transcription as per "Braille Mathematics Code for India" Manual.
- User can enter mathematical symbols not available in regular keyboards.
- On screen soft keyboard available for Indian languages as well as mathematical and scientific symbols.
Talking Dictionary
Bengali to Bengali Talking Dictionary for the Visually Impaired

• To Find Correct Meanings and parts of Speech Information on screen and played in Synthetic Speech for a Bengali word typed.

• Versatile Search facility with Filter Option for different Parts of Speech.

• Facility for Display of Nearest Correct Word Against Incorrectly Typed Word.

• A Database of around 60,000 Words from Standard Bengali Dictionary.

• Facility for Visually Impaired users for typing the word in Braille with Audio Support and Listening to the Meaning in Synthetic Speech.

WEBEL MEDIATRONICS LIMITED
P-1, Taratala Road, Kolkata – 700 088

Phone: 91 – 33 – 2401 7609/9602 0712
Fax: 91 – 33 – 2401 4681
E-mail: webelmedia@gmail.com
Visit us at : www.braille-aid.in
Braille Exam

Computer based Examination Application in Indian languages and English for visually impaired students.

- Questions will be played in audio and students can answer in Braille.
- Automatic checking of correctness.
- Built in database of audio enabled questions and answer categorized as per standard and subject.
- Teachers can add questions/answer in the database.
- Supports English and Indian Languages.

WEBEL MEDIATRONICS LIMITED
P-1, Taratala Road, Kolkata - 700 088

Phone: 91 – 33 – 2401 7699/5602/ 0712
Fax: 91 – 33 – 2401 4081
E-mail: webelmindia@gmail.com
Visit us at: www.braille-sds.in

Page 33 of 169
Annexure B: List of all schools covered under various projects
List of Schools- WML Product installed

1. Voice of World, Kolkata
2. Light House for the Blind, Kolkata
3. Louis Braille Memorial School for the Sightless, Makhla, Uttarpara, Hoogly
4. Ramkrishna Mission Blind Boys’ Academy, Narendrapur, Kolkata
5. Naihati Apex Blind School, 24 Parganas (N)
6. Ramkrishna Vivekananda Mission, Barrackpore, 24 Pgs (N)
7. Burdwan Blind Academy, Burdwan
8. Vivekananda Mission Asram, Chaitanyapur, Purba Medinipur
9. Nabadwip APC Blind School, Nabadwip, Nadia
10. Manbhum Drishi -Pratibandhi Sikshayatan, Purulia
11. Vidyasagar Blind Vocational Training Institution, Midnapore East
12. Helen Keller Sririti Vidyamandir, Krishnanagar, Nadia
13 Ananda Bhawan Deaf & Blind School, Ultubaria, Howrah
14 N E L C School for the Blind, Cooch Behar
15 Jalpaiguri Welfare Organization, Jalpaiguri
16 Jhunka Pratibandhi Alake Niketan, Jhunka, Murshidabad
17 Subodh Sen Smriti, Alipurduar, Jalpaiguri
18 Moyna Ramkrsishnayan Association, Moyna, Purba Midnapur
19 Vivekananda Loksiksha Niketan, Purba Medinipur
20 Ikshupatrika Social Welfare Organisation, Ikshupatrika, Midnapore
21 Karimpur Social Welfare Society, Karimpur, Nadia
22 Sri Aurobindo Institute For Sightless, Suri, Birbhum
23 Mary Scott Home for the Blind Junior High School,
Kalimpong, Darjeeling
24 Calcutta Blind School, Behala, Kolkata
25 Govt. School for the Blind, Nikuthi, Coochbehar
26 Purulia Sanda Mission for Blind, Panshkura, Purba Medinipur
27 R.P. Roy Memorial Blind School, Mangalbari, Malda
28 Rajya Pratibandhi Sammilani, Kolkata
29 Uttarpara Jaikrishna Public Library, Uttarpara, Hooghly
30 Prerona Education Center, Shiliguri
31 Gunabandhu Residential Blind School, Kadobarihat, Jalpaiguri
32 Sri Sri Ramkrishna Sayananda Educational & Carity Trust
(Dristideep Shiksha Niketan), Rampurhat, Birbhum
33 Subodh Kumar Mishra Blind School, Paopia, Malda
34 Nimbad Math Pratibandhi Sikshaniketan, Shankarpur, Paschim Medinipur
35 SATHI (An Institution of Education Training for Deaf and Blind), Khukrea, Paschim Medinipur
36 Divine Fellowship Blind School, Joka, Kolkata
37 Society for Visually Handicapped, Kolkata
38 Bankura Sammilani Blind School, Bankura, Kolkata
39 National Association for the Blind, Kolkata
40 Blind Persons Association, Mallickpur, Kolkata
41 C.S.I School for the Blind, Kanyakumari
42 High School for the Blind, Tirunelveli
43 Indian Association for the Blind, Madurai
44 Amalarkkani School for the Blind, Thiruvannamalai
45 Hellen Keller Centenary Memorial Model School for the Blind, Palakkad
46 Kerala School for the Blind, Malappuram
47 Calicut H.S. School for the Handicapped, Calicut
48 School For The Blind, Ahmedabad
49 Vocational Rehabilitation Training Centre, Ludhiana
50 Institute for the Blind, Chandigarh
51 Govt. H.S. School for Visually Handicapped & H.I. Rajpur
52 Bankura Sammilani Blind School, Bankura
53 School & Rehabilitation Center for the Blind, Betul
54 National Association for the Blind, Indore
<table>
<thead>
<tr>
<th>Number</th>
<th>Institution Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>55</td>
<td>Mahesh Drishtiheen Kalyan Sangh, Indore</td>
</tr>
<tr>
<td>56</td>
<td>Chandra Shekhar Azad Adibasi Dristiheen Punarbasan Kendra, Jhabua</td>
</tr>
<tr>
<td>57</td>
<td>Ahmadi School for the Blind, Aligarh</td>
</tr>
<tr>
<td>58</td>
<td>National Association for the Blind, Lucknow</td>
</tr>
<tr>
<td>59</td>
<td>Akhil Khadi Tatha Gramodyogik Sansthan, Raebareli</td>
</tr>
<tr>
<td>60</td>
<td>Yona Viklang Evan DristiBadhitarh kalyan Sewa Sansthan, Karebhar-Sultanpur</td>
</tr>
<tr>
<td>61</td>
<td>Rajasthan Netraheen Kalyan Sangh, Jaipur</td>
</tr>
<tr>
<td>62</td>
<td>Nab Pheroze &amp; N.M. Rehabilitation Center for the Blind, Mount Abu</td>
</tr>
<tr>
<td>63</td>
<td>Govt. Residential School for Visually Handicapped, Karimnagar</td>
</tr>
<tr>
<td>64</td>
<td>Shri Hari Seva Foundation, Washim</td>
</tr>
<tr>
<td>65</td>
<td>Govt. Residential School For Visually Challenged Girls, Visakhapatnam</td>
</tr>
<tr>
<td>66</td>
<td>The Karnataka Welfare Association for the Blind, Bangalore</td>
</tr>
<tr>
<td>67</td>
<td>Ashakiran Educational &amp; Rehabilitation Society, Kolar</td>
</tr>
<tr>
<td>68</td>
<td>Rangarao Memorial School for Disabled, Mysore</td>
</tr>
<tr>
<td>69</td>
<td>Govt. Boys High School for the Blind, Hyderabad</td>
</tr>
<tr>
<td>70</td>
<td>Israji Devi Shikshan Sansthan, Allahabad</td>
</tr>
<tr>
<td>71</td>
<td>Sri Hanuman Prasad Poddar Andh Vidyalaya, Varanasi</td>
</tr>
<tr>
<td>72</td>
<td>Woman &amp; Child Welfare Centre, Shreeramnagar</td>
</tr>
<tr>
<td>73</td>
<td>Asharkiran School for the Blind, Bidar</td>
</tr>
<tr>
<td>74</td>
<td>Dr. Narendra Bhivapurkar Andh Vidyalaya, Amrawati</td>
</tr>
<tr>
<td>75</td>
<td>School for the Blind ( Guild of Service ), Vellore</td>
</tr>
</tbody>
</table>
76 National Association for the Blind, Kullu
77 The Blind Relief Association, Bhopal
78 Pragya Niketan, Jodhpur
79 Jyoti Sreal School, Shillong
80 Society for the Training and Vocational Rehabilitation of the Disabled, Vadodara
81 School for the Blind, Cuttack
82 S.V.M. School for the Blind, Puri
83 Irna Baka Blind & Deaf School, Malkangiri
84 District Disability Rehabilitation Center, Kalahandi
85 Red Cross School for the Disabled, Balangir
86 S.J.B.B.K Institute, Bhadrak
87 Govt. High School for the Blind, Sambalpur
88 Bhairabi Special School, Khurda
89 Jhareswari Spl. School for the Handicapped, Jharsuguda
90 M.K.C.G. School for the Blind and Deaf, Gajapati
91 Sri Ram Chandra School for the Blind, Mayurbhanj
92 Handicapped Welfare Institute, Balasore
93 Red Cross School for the Blind, Banabasi Seva Samiti, Kandhamal
94 School for the Blind, Koraput
95 I.I.E.C., Dasapalla, Nayagarh
96 Asra Special School for Disabled, Jagatsingpur
97 Training Center for the Teachers of the Visually Handicapped, Bhubaneswar
<table>
<thead>
<tr>
<th>No.</th>
<th>Institution Name and Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>98</td>
<td>Red Cross School for the Blind, Ganjam</td>
</tr>
<tr>
<td>99</td>
<td>School for the Blind, Keonjhar</td>
</tr>
<tr>
<td>100</td>
<td>Alok School for the Blind, Dhenkanal</td>
</tr>
<tr>
<td>101</td>
<td>School for the Blind, Sundargarh</td>
</tr>
<tr>
<td>102</td>
<td>A.V.A. Special School for Handicapped Children, Puri</td>
</tr>
<tr>
<td>103</td>
<td>Physically Handicapped School, Bargarh</td>
</tr>
<tr>
<td>104</td>
<td>District Special School, Nuapada</td>
</tr>
<tr>
<td>105</td>
<td>Municipal Blind School, Kendrapara</td>
</tr>
<tr>
<td>106</td>
<td>District Handicapped Welfare School, Sonepur</td>
</tr>
<tr>
<td>107</td>
<td>School for the Blind, Angul</td>
</tr>
<tr>
<td>108</td>
<td>School for the Blind, Deogarh</td>
</tr>
<tr>
<td>109</td>
<td>School for the Blind, Jaipur</td>
</tr>
<tr>
<td>110</td>
<td>School for the Blind, Boudh</td>
</tr>
<tr>
<td>111</td>
<td>School for the Blind, Nawarangpur</td>
</tr>
<tr>
<td>112</td>
<td>School for the Blind, Raygada</td>
</tr>
<tr>
<td>113</td>
<td>The Poona School &amp; Home for the Blind, Pune</td>
</tr>
<tr>
<td>114</td>
<td>Smt. Kamla Mehata Dadar School for the Blind, Mumbai</td>
</tr>
<tr>
<td>115</td>
<td>Govt. Higher Secondary Girls School for the blind, Hyderabad</td>
</tr>
<tr>
<td>116</td>
<td>Department of Educational Technology (Sr. Lecture), Santacruz (W)</td>
</tr>
<tr>
<td>117</td>
<td>Brajkishore Netaheen Balika Vidyalaya, Ranchi</td>
</tr>
<tr>
<td>118</td>
<td>Sparsh Rajiya Drishti Badhi Balika Vidyalya, Saharanpur</td>
</tr>
<tr>
<td>119</td>
<td>Shri Vrajlal Durlabhji Parekh Andh Mahila Vikash Grah, Rajkot</td>
</tr>
</tbody>
</table>
120 Rashtriya Vrijendra Andh Kanya Senior Secondary School, New Delhi
121 Sri Adichunchanagiri Shikshana Trust, Bangalore
122 Institute for the Visually Handicapped (Girls), Agartala
123 Nabatwip A.P.C Blind School, Nabatwip
124 Red Cross School for the Blind, Ganjam
125 Jorhat Blind Institute, Jorhat
126 National Institute for visually Handicapped, Poonamallee
127 St. Joshep's School For The Blind, Madurai
128 Netaheen Vikash Sansthan, Jodhpur
129 Samaritan's Blind School, Aizawl
130 Andhra Blind Model High School, West Godawari
131 I.E.L.C School For The Blind, Krishnagiri
132 Govt Blind Girls School Davangere, Davangere
133 Govt. Residential School/ Jr. College Visually Handicapped, Mahaboobnagar
134 The ideal Blind School, Takyel, Imphal
135 Sreemant Sankar Mission Blind School, Nagaon
136 Assam Andha Sishu Vidyalay, Lakhimpur
137 Andh Kanya Prakasha Gruh, Ahmedabad
138 Guwahati Blind High School, Guwahati
139 Denvar School for the Blind, Hyderabad
140 School / Home for Visually Impaired, Shimla
141. Institution for the Children with Special Abilities, Mandi

142. Pallava Council for Integrated Education, Vellore

143. Little Flower Convent H. Sec, Chennai

144. Kerala Institution for the Blind, Thrissur

145. Bhairutan Damani Blind School, Solapur

146. Govt. Institute for the blind, Panipat

147. Ashakiran Residential School for the Blind Children, Chikmagolur

148. Karnataka Navaaachethana School for the Blind, Tumkur

149. Rashtriya Drushtiin shiksan & Punarvasan Sansthan, Nagpur

150. Residential School for the Blind, Amravati

151. Louis Braille Memorial School for the sightless, Hooghly

152. Centre for Special Education for the Disabled Children, Jalpaiguri

153. Govt. School for the Blind, Kettayam

154. Govt. School for the Blind, Vidyapur

155. Govt. School for the Blind, Kunnakkulam

156. Jawaharlal Nehru Memorial Institution, Namchi

157. Rabindra Bharati University, Kolkata

158. Shikshita Yuva Sewa Samiti, Basti

159. Calcutta Blind School, Kolkata,

160. Vivekananda Mission Asram, Residential School for the Blind, Chhatrapur

161. Bhima Bhoi School for The Blind, Unit III, Bhubaneswar

162. Jorhat Blind Institute, Na-Ali, Jorhat
163. The Ideal Blind School, Takyr, Imphal
164. Institute for the Visually Handicapped, Narsingarh, West Tripura
165. National Institute for the Visually Handicapped (NIVH), Dehradun
166. Blind Relief Association, New Delhi
167. Govt. Institute for the Blind, Braille Bhawan, Ludhiana
168. Training Centre for Adult Blind, Panipat
169. Govt. Inter-college School for the Blind, Lucknow
170. Jeevan Jyoti School and Community Based Rehabilitation for the Blind, Varanasi
171. National Association for the Blind, India, Mumbai
172. Happy Home and School for the Blind, Mumbai
174. Secondary School for the Blind, Dr. Vikram Sarabhai Road, Ahmedabad
175. Smt. M.K. Mehta School for the Visually Handicapped, Palanpur
176. The Belgaum District Association for the Blind, Belgaum
177. Government High School for the Blind Girls, C-137, Hyderabad
178. International Human Resource Development Centre for the Disabled, Ramkrishna Mission Vidyalaya, Coimbatore
179. St. Louis Institute for the Deaf and the Blind, Chennai
180. Govt. School for the Blind, Thiruvananthapuram
181. Shree Ramana Maharishi Academy for the Blind, Bangalore
182. Visakha Model School for the Blind, Visakhapatnam
183  Govt. Deaf and Blind School, Karbala Road, Bhopal
184  St. Michael's School for the Blind, Ranchi
185  Bihar Blind People's Care Society, Patna
186  M.P. Welfare Association for the Blind, Indore
187  Govt. Higher Secondary School for the Blind, Jabalpur
188  The Blind Relief Association, Nagpur
189  Chatra Physically Handicapped & Social Welfare Institute, Muzaffabad
190  Anne Sullivan School for Sightless, Kalyani
Annexure c: www.braille-aids.in

IT Enabled Braille Education in Indian Languages

Welcome to www.braille-aids.in: a user!

Technology Developed

Assistive Devices
- Automatic Braille Embosser - Modified Perkins Braille
- Tactile Reader & e-Library - Electronic Braille Display
- Braille Key Board & e-Classroom - Braille Writing Device

Software
- Text2Braille - Text-to-Braille transcription software
- DirectBraille - Braille-to-Text transcription software
- ReadBraille - Touch Reading software for Tactile Reader
- BrailleWriter - Braille writing software
- EasyBraille - Interactive multimedia CD-ROM for learning Braille
- WIAMTS - Mathematics Braille Transcription Software
- Screen Reader - Screen Reading software

Braille Resource Archive

Click here to get the Braille Archive in major Indian languages.

For IT enabled Braille education infrastructure development, Weble Mediatronics Limited has installed IT based...
Availability of resources has been the major roadblock in the progress of the visually impaired, especially in education and training. Feel free to access Braille resources already published in various Indian languages through www.braille-aids.in.

Apart from English, the resources are available in the following Indian languages:

<table>
<thead>
<tr>
<th>Hindi</th>
<th>Punjab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bengali</td>
<td>Kannada</td>
</tr>
<tr>
<td>Oriya</td>
<td>Malayalam</td>
</tr>
<tr>
<td>Gujarati</td>
<td>Tamil</td>
</tr>
<tr>
<td>Marathi</td>
<td>Telugu</td>
</tr>
<tr>
<td>English</td>
<td>Other Indian Languages</td>
</tr>
</tbody>
</table>

Books available in www.braille-aids.in

Language: English

1. Gem’s English Primer Class 2
2. Arms And The Man
3. Loktak Literature Reader Class – IX
4. New Oxford Modern English
5. P K Dey Sarkar Grammar
6. 10 Stories English
7. Aravali Reader Class – VI
8. Aravali Reader Class – VII
9. English Reader Class – VIII
10. Tenth Text Book
11. Loktak Reader Class – X
12. Braille Learning Book
13. Parent Awareness Training Book
14. English Grammar & Translation for Class – III & IV
15. Shakespeare – A Midsummer Night’s Dream
16. Shakespeare – The Writer’s Tale
17. Shakespeare – The Tempest
18. Shakespeare – Romeo and Juliet
19. Shakespeare – Perils
20. Shakespeare – Hamlet
21. Shakespeare – As you like it
22. Outline on Indian Philosophy
23. Modern India
24. B.A. Political Science & Descriptive Portion
25. Composite Course in History & Civics Class – VII Sikkim
26. Computer
27. Court Case
28. Discovery of India by Jawaharlal Nehru
29. Elementary English Class – 3 Uttar Pradesh
30. English Book Class – 6 Karnataka
31. English Book Class – 7 Karnataka
32. English Book Class – 8 West Bengal
33. English Class – 1 Bihar
34. English Class – 3 Bihar
35. English Class – 7 Bihar
36. English Class – 7 Jharkhand
37. English Reader Class – 1 M.P.
38. English Reader Class – 2 M.P.
39. English Reader Class – 3 M.P.
40. English Reader Class – 4 M.P.
41. English Reader Class – 5 M.P.
42. English Reader Class – 6 M.P.
43. English Reader Class – 7 M.P.
44. English Reader Class – 8 M.P.
45. English Reader Standard – XII Tamilnadu
46. English Text Book Class – VIII Tamilnadu
47. English Text Book Class – X Tamilnadu
48. English Text Book Class – 3 Andhra Pradesh
49. English Text Book Class – 4 Andhra Pradesh
50. English Text Book Class – 5 Andhra Pradesh
51. English Text Book Class – 6 Andhra Pradesh
52. English Text Book Class – 7 Andhra Pradesh
53. English Workbook Class – 3 Bihar
54. Essay Book
55. Focus on Environmental Studies Part 2 Class 2 Bihar
56. Gem’s English Primer Class – 2 West Bengal
57. Grammar & Composition Higher Secondary English Paper – 2 West Bengal
58. Higher Secondary English Selection (Prose) West Bengal
59. Judgment of the Court
60. Holafath Direct Approach to interactive English Main Course Book 2 Class 1 Bihar
61. Interact in English (Main Course Book) Class – K Sikkim
62. Interact in English Literature Reader Class – K Sikkim
63. Holafath Direct Approaching to interactive English Work Book Class 3 Bihar
64. International Rules for Cricket for the Blind
65. Learn English Class – 5 Jharkhand
66. Letter Writing Book M.P.
67. Lekta English Reader Class – 4 Manipur
68. Lekta English Reader Class – 6 Manipur
69. Lekta English Reader – II Class – 3 Manipur
70. Lekta English Reader Part – II Class – 3 Manipur
71. Lekta English Reader Part – IV Class – 5 Manipur
72. Lektak English Reader Part – VI Class – 7 Manipur
73. Lektak English Reader Part – VII Class – 8 Manipur
74. Lektak Literature Reader Class – 10 Manipur
75. Mass Communication B.A. P-I Maharashtra
76. Memorandum of Association of Akhil Bhartiya Bristhini Kalyan Sangha
77. Microsoft Power point
78. My English Book Class – II Maharashtra
79. My English Book Class – III Maharashtra
80. My English Book Class – IV Maharashtra
81. Our Way to English Class – 6 Sikkim
82. Our Way to English Class – 7 Sikkim
83. P.K.D. Sarkar Grammar West Bengal
84. Poetry
85. Social Science B.E. 1st year Maharashtra

Language: Hindi

1. Katha Kunj
2. Bal Sanskritam Part – 3
3. Hindi Class – VII
4. Bal Bharti Class – I
5. Bal Bharti Class – IV
6. Paper Class – VI
7. Paryavaran Aur Hum
8. Sangeet Shastra Darpan Class – X
9. Sanskrit Class – IV
10. Social Science Class – IV
11. Science Class – 8
12. Science Class – 7
13. Sanskrit Class – 8
14. Sanskrit Class – 7
15. Sanskrit Class – 6
16. Samajik Vigyan Class – 6
17. Samajik Vigyan Class – 7
18. Sahayak Bachan Class – 8
19. Paryabaran Class – 3
20. Paryabaran Class – 4
21. Paryabaran Class – 5
22. History Class – 8
23. Civics Class – 8
24. Bal Bharti Class – 1
25. Bal Bharti Class – 2
26. Bal Bharti Class – 3
27. Bal Bharti Class – 4
28. Bal Bharti Class – 5
29. Bal Bharti Class – 6
30. Bal Bharti Class – 7
31. Bal Bharti Class – 8
32. Bal Sanskritam Part – 1
33. Hindi Class – X Part – 3
34. Kishor Bharti Part - III Class - 8 Bihar
35. Prachin Bharti Part - I Class - 6 Bihar
36. Bal Bharti Class - 5 Jharkhand
37. Chemistry Yojna Class - 9 Jharkhand
38. Samajvad Chetna Sansar Class - 5 Jharkhand
39. Parent Awareness Training Book Jharkhand
40. Physics Class - 9 VII - I Jharkhand
41. Science and Technology Class - 7 Jharkhand
42. Bal Bharti Class - 8 M.P.
43. Bal Vidyaruchi Class - 6 M.P.
44. Bharati Class - 1 M.P.
45. Bharati Class - 2 M.P.
46. Bharati Class - 3 M.P.
47. Bharati Class - 4 M.P.
48. Bharati Class - 5 M.P.
49. Bharati Class - 6 M.P.
50. Bharati Class - 7 M.P.
51. Shoolbol Class - 6 M.P.
52. Shoolbol Class - 8 M.P.
53. Civics Class - 8 M.P.
54. Hindi Class - 10 Part - II M.P.
55. Hindi Class - 10 Part - III M.P.
56. History Class - 11 M.P.
57. History Class - 12 M.P.
58. History Class - 8 M.P.
59. Itihas Class - 7 M.P.
60. Math Class - 6 M.P.
61. Math Class - 8 M.P.
62. Paryayan Class - 3 M.P.
63. Paryayan Class - 4 M.P.
64. Paryayan Class - 5 M.P.
65. Sahyak Bachan Class - 6 M.P.
66. Samajik Vigyan Class - 6 M.P.
67. Samajik Vigyan Class - 7 M.P.
68. Sanskrit Class - 6 M.P.
69. Sanskrit Class - 7 M.P.
70. Sanskrit Class - 8 M.P.
71. Science Class - 7 M.P.
72. Science Class - 8 M.P.
73. Bal Sanskritan Part - I Rajasthan
74. Bal Sanskritan Part - II Rajasthan
75. Bal Sanskritan Part - II Rajasthan
76. Bigyan Class - 6 Rajasthan
77. Bigyan Class - 7 Rajasthan
78. Bigyan Class - 8 Rajasthan
79. Hindi Class - 4 Rajasthan
80. Hindi Class - 6 Rajasthan
81. Hindi Class - 6 Rajasthan
82. Hindi Class - 7 Rajasthan
83. Hindi Class - 8 Rajasthan
<table>
<thead>
<tr>
<th>No.</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>134</td>
<td>Samajik Bigyan Bhogol - I Class - 0 Rajasthan</td>
</tr>
<tr>
<td>135</td>
<td>Samajik Bigyan Class - 6 Rajasthan</td>
</tr>
<tr>
<td>136</td>
<td>Samajik Bigyan - II Bhogol Class - 7 Rajasthan</td>
</tr>
<tr>
<td>137</td>
<td>Samajik Bigyan - II Class - 7 Rajasthan</td>
</tr>
<tr>
<td>138</td>
<td>Bharat Bharti Book Maharashtra</td>
</tr>
<tr>
<td>139</td>
<td>Story Book Class - 4 Maharashtra</td>
</tr>
<tr>
<td>140</td>
<td>Hindi Naba Malica Class - 8 Manipur</td>
</tr>
<tr>
<td>141</td>
<td>Sugam Hindi Siksam Bhag - II Manipur</td>
</tr>
<tr>
<td>142</td>
<td>Sugam Hindi Siksam Bhag - III Manipur</td>
</tr>
<tr>
<td>143</td>
<td>Sugam Hindi Siksam Bhag - IV Manipur</td>
</tr>
<tr>
<td>144</td>
<td>Sugam Hindi Siksam Bhag - V Manipur</td>
</tr>
<tr>
<td>145</td>
<td>Braille Learning Book</td>
</tr>
<tr>
<td>146</td>
<td>Hindi Kahaniya</td>
</tr>
<tr>
<td>147</td>
<td>Khane Khajana</td>
</tr>
</tbody>
</table>

Language: Bengali

1. Aban Thakurer Chotodor Samvar
2. Barna Parichoy Part - II
3. Bharat-O-Bhumandol Class - VI
4. Bisutibhusan Racharabali
5. Charipad brol
6. Jibanandha Racharabali, brol
7. Rabindra Racharabali Vol - 1
8. Rabindra Racharabali Vol - 10
9. Rabindra Racharabali Vol - 4
10. Rabindra Racharabali Vol - 5
11. Rabindra Racharabali Vol - 6
12. Rabindra Racharabali Vol - 7
13. Rabindra Racharabali Vol - 8
15. Rabindra Racharabali Vol - 11
16. Rabindra Racharabali Vol - 12
17. Sahitya Dipika Class - 8 Vol - 1 brol
18. Sahitya Dipika Class - 6 Vol - 1 brol
19. Sahitya Dipika Class - 6 Vol - 2 brol
20. Sahitya Parichoy Class - 7 Vol - 1 brol
21. Sahitya Parichoy Class - 7 Vol - 2 brol
22. Banaparichoy Part - I
23. Banaparichoy Port - II
24. Bhogol Class - V
25. Bhogol Class - VI
26. Bhogol Class - VII
27. Bhogol Class - VIII
28. Itihas Class - III
30. Itihas Class – V
31. Itihas Vhag Three Class – VI
32. Prachin Itihas Class – VI
33. History Class – VII
34. History Class XI – XII
35. Vidyasagar
36. Rammohan
37. Shahajpath
38. KethaKunj bri
39. Nibachita Vab Samprasaran
40. Swarimachita Chotoder Shresta Galpo
41. Kishalaya – II.p2
42. Asantajatik Samparker Itihas
43. Achnik Bhooretor Itihas
44. Achnik Bharater Rupantan by : Samaj Malik
45. Achnik Purba Asia
46. Bharater Itihas by : Parbathatashy Malty
47. Bharater Itihas by : Ray & Chattopachya
48. Chiner Itihas
49. Europe Bibatan
50. Europe Itihas by : Prafulla Chakroborty
51. Europe Itihas
52. Final Bharatiya Darshan
53. History
54. Japanese Itihas
55. Madhyajuger Bharat (Mughal Amal)
56. Madhyajuger Europe
57. Nikotwa
58. Prachin Bharater Itihas by : Subil Chattejoe
59. Peschayya Darshan & Juddibiyang
60. Samapdarshan & Rastradarpshan
61. Peschayya Darshan (Achnik)
62. Peschayya Darshaner Itihas
63. Prachin Bharater Itihas by Subil Garguly
64. Sftsuder Paribesh Class – 1
65. A Master of Tense IX –X
66. Chitra Bodh, Bangla Bakaran Class – V
67. Bharatiya Sabyateti Rup-O-Resha – IX
68. Bangla Sehtiyer Itihas XI – XII
69. Madhyamik Rachana Bichinta Class – IX
70. Madhyamik Rachana Bichinta Class – X
71. Bengali Note Bock XI – XII
72. Kishalaya
73. Education Class XI-XII
74. Majar Chhara
75. Bengla Sehtiyer Itihas Class XI – XII
76. Kalo Patitar
77. Remur Sumali, Bri
78. Saral Pran Bigyan Class – VI
79. Jeevan Bigyan Parishay Class – X
80. Bani Malya Class – VII
81. Bani Malya Class – VIII
82. Physical Science Class = VI
83. Philosophy Class XI – XII
84. School Book Class – I
85. School Book Class – II
86. School Book Class – III
87. School Book Class – IV
88. School Book Class – V
89. School Book Class – VI
90. School Book Class – VII
91. School Book Class – VIII
92. School Book Class – IX
93. School Book Class – X
94. School Book Class – XI
95. School Book Class – XII
96. Adhunik Bharat 150 Bachhor
97. Bankim Rachanabali
98. Bangla Sahityer Itihas
99. Prasna Utoro Uchha Madhyamik Itihas
100. Prasna Utoro Uchha Madhyamik Rastra Bigyan
101. Calcutta Blind School Magazine
102. Shisudar Paribash Class – I
103. Shyama
104. Vidyasagar
105. Uchchamadhyamik Bangla Sahityer Samiksha (Note Book)
106. Pol Science Question & Answer
107. Helen Keller
108. Meghnadbadh Kavya
109. Harbola
110. Subhada 1st Adhaya
111. Subhada 2nd Adhaya
112. Baraddi
113. Nababidhan
114. Palisameej
115. Sarat Rachanabali Part – II
116. Sarat Rachanabali Part – III
117. Srikanta 1st Parba
118. Srikanta 2nd Parba
119. Srikanta 3rd Parba
120. Srikanta 4th Parba
121. Economic Geography Class XI – XII
122. Chitragita
123. Uchha Madhyamik Bangla Sarkalar Class XI – XII
124. Bharat-O-Bhumondo Class – 8
125. Bana Parishay
120. Bengali Class – V
127. Bengali Class – VI
128. Bengali Class – VII
129. Bengali Grammar Class – V
130. Bodhon
131. Anandamath
132. Devi Chowdhurani
133. Krishmakanta
134. Rojehingha
135. Radharani
136. Rajani
137. Chandrashekher
138. Sitaram
139. Durgeshsandini
140. Indira
141. Jugalanguriya
142. Kapal Kundala
143. Mrinalini
144. Vivekananda Rachanabali Part – I
145. Vivekananda Rachanabali Part – II
146. Vivekananda Rachanabali Part – III
147. Vivekananda Rachanabali Part – IV
148. Bengali Class – VIII
149. Darsan Class XI-XII

Page 54 of 169
Annexure D

Manual of Braille Products

- DirectBraille - Braille to Text Software for the visually impaired in Indian languages
- textBraille Software - Text to Braille Transcription Software in Indian languages
- ReadBraille - Paperless Braille reading in Indian languages
- WIMATS - Math Braille Software
Direct Braille English 7.0 User Guide for Windows®

This manual, as well as the Software described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this manual is furnished for informational use only, is not subject to change without notice, and should not be construed as a commitment by Webel Mediatronics Limited. Webel Mediatronics Limited assumes no responsibility or liability for any errors or inaccuracies that may appear in this book.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of Webel Mediatronics Limited.

All the trademarks are the property of their respective owners.

Written and designed at Webel Mediatronics Limited, P-1 Taratala Road, Kolkata – 700088, West Bengal, India
## Contents

<table>
<thead>
<tr>
<th>SI No.</th>
<th>Topics</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Introduction</td>
</tr>
<tr>
<td></td>
<td>About this manual</td>
</tr>
<tr>
<td></td>
<td>System Requirement</td>
</tr>
<tr>
<td></td>
<td>Installing Direct Braille English 7.0</td>
</tr>
<tr>
<td></td>
<td>Registration</td>
</tr>
<tr>
<td>1</td>
<td>Getting Started.</td>
</tr>
<tr>
<td>1.1</td>
<td>Use of Mask.</td>
</tr>
<tr>
<td>1.2</td>
<td>Create a New File and Open an Old File</td>
</tr>
<tr>
<td>2</td>
<td>Looking at the Work Area – Direct Braille English</td>
</tr>
<tr>
<td>2.1</td>
<td>Application Area</td>
</tr>
<tr>
<td>2.2</td>
<td>Editing</td>
</tr>
<tr>
<td>2.3</td>
<td>Saving a File</td>
</tr>
<tr>
<td>2.4</td>
<td>Closing a File</td>
</tr>
<tr>
<td>2.5</td>
<td>Exit from Application</td>
</tr>
<tr>
<td>2.6</td>
<td>Sound Feedback</td>
</tr>
<tr>
<td>3</td>
<td>Rules for Braille Entry in Direct Braille</td>
</tr>
<tr>
<td>3.1</td>
<td>Double Inverted Comma</td>
</tr>
<tr>
<td>3.2</td>
<td>Double Exclamatory</td>
</tr>
<tr>
<td>3.3</td>
<td>Numerical symbol</td>
</tr>
<tr>
<td>4</td>
<td>Embossing</td>
</tr>
<tr>
<td>4.1</td>
<td>Selecting a File</td>
</tr>
<tr>
<td>4.2</td>
<td>Selecting No. of Line and No. of Character per Page</td>
</tr>
<tr>
<td>4.3</td>
<td>Embossing By Sighted.</td>
</tr>
<tr>
<td>4.4</td>
<td>Embossing By Blind.</td>
</tr>
<tr>
<td>5</td>
<td>Braille-to-Text Conversion</td>
</tr>
<tr>
<td>5.1</td>
<td>Text Printout</td>
</tr>
</tbody>
</table>
Introduction

Welcome to the Direct Braille English 7.0 Software - a Windows® based user-friendly Braille-to-Text Transcription software for English Language. No extra hardware is required for Braille entry. Braille entry terminal is nothing but a conventional QWERTY keyboard having musk over it so that the blind can easily access the required keys.

The software decodes the Braille code from the keyboard and generates the Braille characters in display as well as printable output. With audio support a visually impaired person can type in Braille and get ink print as well as Braille print without anybody’s assistance. Thus an easy communication can be established between the sightless persons and the sighted persons.

About this manual

The Direct Braille English 7.0 User Guide provides detailed information about the Direct Braille English 7.0 tools and operations. It is designed to use as a reference tool in your day-to-day work with Direct Braille English 7.0 Software. The cross-platform manual provides instructions for using Direct Braille English 7.0 Software on Windows 98® and higher version of Windows.

Before using this manual, you need to install programs by following the instructions given in this chapter.

The manual assumes you have a working knowledge of Windows 98® and higher version of Windows and its standard operations.

System Requirement

To install Direct Braille English 7.0 Software following System to be required:

Specification of Computer:

Pentium 4, 128 MB RAM, 2 GB Hard Disk, 1.44 MB Floppy Disk Drive, 52X CD-ROM Drive, Sound Card, Color Monitor, 104-Key Keyboard, Mouse, Speaker, 2 COM Ports, 2 PCI Slots free.

Windows 98® Preloaded

Braille Embosser: Modified Perkins Brailler® or Index®

Installing Direct Braille English 7.0

Put the Direct Braille Eng 7.0 CD on the CD-ROM Drive. Run the Setup.exe. Follow the on-screen instructions. After successful installation ‘Restart’ the PC.
Registration

WML is confident about that the Direct Braille English 7.0 program greatly increases your ability to increase the speed of typing in Braille and communicating with the sighted world. Please register your copy so that you will be the registered user of the software, so that WML can continue to provide you with the higher-quality Software, other technical support if needed during the operation.

During the first run of the Software you will get a Registration Key Number. Please copy the number and send us through mail webelmedia@gmail.com or call us at +91-33-24014081 / 5602 +91-33-2282-3800 for the Liberation Key Number. Within few moments your copy will be personalized.

Chapter – 1
Getting Started

1.1 Use of Mask

To operate Direct Braille English 7.0 you need only 24 Keys for navigation and control out of 110 keys. For ease of operation a special type of Mask is designed. With the help of the Mask a visually challenged persons can enter data quite easily as they can find the required keys faster.

To run the Direct Braille English 7.0 press the shortcut icon from your QWERTY Keyboard. Now you will be guided by audio.

The corresponding Braille Dots and assigned Keys are mentioned below.

F: dot 1 of Braille code
D: dot 2 of Braille code
S: dot 3 of Braille code
J: dot 4 of Braille code
K: dot 5 of Braille code
L: dot 6 of Braille code

ENTER: Start from a new line
SPACE BAR: To write blank space
BACKSPACE: To erase the previous character

ESC KEY: To exit from the application by saving / without saving / Cancel the exit command

F1: To print the corresponding text file
F2: To save the current file

F3: To close the current file by saving / without saving

F4: To provide sound feedback selectively by toggling the key

F5: To select the print window, to get information about current line number / Page number.

F6: printing by a visually impaired person

F7: Unselect a particular page by visually impaired person

UP ARROW KEY: To move the cursor to the previous line

DOWN ARROW KEY: To move cursor to the next line

LEFT ARROW KEY: To move cursor one bit left

RIGHT ARROW KEY: To move cursor one bit right

PAGE UP: To move cursor to the previous page

PAGE DOWN: To move cursor to the next page

1.2 Create a New File and Open an Old File

The user can open a new file or an existing file depending upon his choice. To open a new file, press the Braille code of ‘N’. To open an existing file, press the Braille code of ‘P’. If the user types any Braille code other than ‘N’ & ‘P’ in three successive choices, then the software gives a warning message to remind the user.

If the user types the Braille code of ‘N’ then the user wants to open a new file. Then the user must type the filename (in English). Whenever user types any Braille character then the particular Braille character is displayed in enlarged version on the top left portion of the screen. The corresponding text will be displayed on the lower end of the screen.

A new filename is now being constructed which is displayed in ink format. Whenever the user press the NEWLINE (enter) key, the filename is registered and a blank page is created where the user can enter the Braille code directly in the chosen language.
2.1 Application Area

The Braille pattern can be entered directly using the assigned six keys. The user can write any text, prose as well as poetry in Braille. Whenever the user writes any character, the Braille pattern as well as the text pattern of that character is displayed on the screen & the corresponding sound file is played.

If the speed of the entry is sufficiently high then the corresponding sound file are followed sequentially. So the sound feedback is made optional. By pressing the MUTE (F4) key alternatively, the user can select / silence the sound feedback.

2.2 Editing

If the user opens an existing file, the Braille cursor marks at the end of file. The user can add new text at the end of the existing document; edit the current text by moving the cursor in the desired position. Using four arrow keys with sound feedback on, the user can move the Braille cursor and locate the desired position. The edited document can be saved in the file. The UP / DOWN ARROW key moves the Braille cursor position, by default 36 text character, in the forward / backward direction. To move character-by-character, press LEFT / RIGHT ARROW key. To move to the previous page press Page Up key and to move to the next page the users have to press Page down key in the QWERTY keyboard. To insert new character, place it in the desired location. To delete the existing character place the cursor position just right to it & press ERASE key.

2.3 Saving a File

During the entry of Braille the user can save the file by pressing SAVE (F2) key. When handling any large text document the user must press SAVE key after 15 minutes interval of time.

2.4 Closing a File
To close the currently opened file, the user must press CLOSE (F3) key. An option is provided whether you want to close the file after saving it unto the latest modification or close the file without saving it. To save the file, press the Braille code of ‘H’, otherwise press the Braille code of ‘N’ to close the file without saving it. Depending upon the user’s choice the file can be closed & a new or existing file can be opened.

2.5 Exit from the Application

The user can exit from the application at any time whenever EXIT (Esc) key is pressed. If no file is opened in the workspace then after pressing EXIT key the program execution stops automatically. If a file is opened, then the user have to decide whether he wants to save the file before quit or quit without saving the file or continue to work on the same file. Press the Braille code of ‘H’ to save it, press the Braille code of ‘N’ not to save the file. Once the EXIT key is pressed, if the user wants to continue the current job, press the Braille code of ‘P’.

2.6 Sound Feedback

The sound feedback may be selected or silenced by alternatively pressing MUTE (F4) key. If the speed of the user is sufficiently high, then the sound will follow the typed text after a delay. It is suggested to make sound feedback off during entry of text & activate it during the time of editing.

Chapter – 3

Rules for Braille Entry in DirectBraille

Since all Braille characters are represented in six-dot configuration, only 63 different combinations are possible. In some cases Braille representation of two different characters are same, some special rules are incorporated to distinguish between them.

- **3.1 Double Inverted Comma**
  
  Braille pattern of ‘closing double inverted coma’ and Bengali Character ‘jha’ are same. When the user want to type double closing inverted coma then he must type ‘coma’ before the Braille pattern other wise it will be interpreted as Bengali Character ‘jha’.

- **3.2 Double Exclamatory**
  
  Braille pattern of ‘exclamatory symbol’ and Bengali Character ‘fa’ are same. When the user want to type exclamatory symbol then he must type ‘comma’ before the Braille pattern other wise it will be interpreted as Bengali Character ‘fa’.

- **3.3 Numerical Symbol**
  
  To write the number there is a convention to put the numerical symbol. Since the Braille code of
Bengali Character “murdhanyana” and numeric symbol are same, so put a dot2 in front of dot 3456 to indicate that it is a number.

Chapter – 4
Embossing

The printer is to be connected at COM1 port.

4.1 Selecting a File

Run the package, when the wave file (‘Open a new file by pressing the Braille code of ‘N’/ open an existing file by pressing the Braille code of ‘P’).

4.2 Selecting No. of Line and No. of Character per Page

By default, the number of characters in a line is set to 36. But user can select any value (not exceeding 36) .To utilize the maximum page area, 25 lines are selected per page.

4.3 Braille Print By Sighted Person

When the welcome sound is being played then press F5 key and the print dialog will be activated.

The print window is menu based & self-explanatory. The content of the selected file can be viewed by clicking the view option.

Before clicking ‘print’ button, the page formatting information must be selected from the window. The print window is designed to take the Braille printing using the modified Perkins Braille Printer.

If the document is a multi-page document then after printing the first page, insert a new blank page and then click 'continue’ button. Once the complete file has been printed the page set up configuration will be saved automatically. Selected printing facility is there to print a particular page.

4.4 Braille Printing By Visually Impaired

To start printing by the visually impaired person, first open the file
you want to print. Press F2, if there is any modification in the content. When the printer is ready, press F6 key, the printing starts with the supporting voice message. If the user wants to skip printing the current page, then Press F7 quickly, before printing starts. Otherwise the current page will get printed. For multi-page document, replace the paper and press F5. Thus the complete document can get printed.

Congratulations!

You have successfully prepared your first Braille Material through Direct Braille Eng 7.0

Chapter – 5
Braille-to-Text Conversion

5.1 Text Printout

The generated text can be printed using “Notepad” application. F1 key is assigned for text printing.

Now open the typed Braille file and press F1. The generated text file will be opened using the common word processor program “Notepad”. After viewing the text content, the print window of “Notepad” will appear on the monitor with its default setting and the print job will start automatically.

After a minimum delay, the print window as well as “Notepad” application will close automatically. Thus the typed matter in Braille will get converted to text, and the visually impaired persons can be made capable to take the print out of the Braille as well as the text independently.
<table>
<thead>
<tr>
<th>Letter /Symbol</th>
<th>Braille Code</th>
<th>Letter /Symbol</th>
<th>Braille Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>⠑</td>
<td>U</td>
<td>⠑</td>
</tr>
<tr>
<td>B</td>
<td>⠟</td>
<td>V</td>
<td>⠟</td>
</tr>
<tr>
<td>C</td>
<td>⠚</td>
<td>W</td>
<td>⠚</td>
</tr>
<tr>
<td>D</td>
<td>⠔</td>
<td>X</td>
<td>⠔</td>
</tr>
<tr>
<td>E</td>
<td>⠙</td>
<td>Y</td>
<td>⠙</td>
</tr>
<tr>
<td>F</td>
<td>⠜</td>
<td>Z</td>
<td>⠜</td>
</tr>
<tr>
<td>G</td>
<td>⠛</td>
<td></td>
<td>⠛</td>
</tr>
<tr>
<td>H</td>
<td>⠆</td>
<td></td>
<td>⠆</td>
</tr>
<tr>
<td>I</td>
<td>⠓</td>
<td>;</td>
<td>⠓</td>
</tr>
<tr>
<td>J</td>
<td>⠕</td>
<td>?</td>
<td>⠕</td>
</tr>
<tr>
<td>K</td>
<td>⠗</td>
<td>!</td>
<td>⠗</td>
</tr>
<tr>
<td>L</td>
<td>⠖</td>
<td>:</td>
<td>⠖</td>
</tr>
<tr>
<td>M</td>
<td>⠕ ⠖</td>
<td>“ ”</td>
<td>⠕ ⠖</td>
</tr>
<tr>
<td>N</td>
<td>⠑ ⠜</td>
<td>’ ’</td>
<td>⠑ ⠜</td>
</tr>
<tr>
<td>O</td>
<td>⠖ ⠖</td>
<td>( )</td>
<td>⠖ ⠖</td>
</tr>
<tr>
<td>P</td>
<td>⠵</td>
<td>[ ]</td>
<td>⠵</td>
</tr>
<tr>
<td>Q</td>
<td>⠓ ⠓</td>
<td>–</td>
<td>⠓ ⠓</td>
</tr>
<tr>
<td>R</td>
<td>⠕ ⠕</td>
<td>--</td>
<td>⠕ ⠕</td>
</tr>
<tr>
<td>S</td>
<td>⠓ ⠖</td>
<td>----</td>
<td>⠓ ⠖</td>
</tr>
<tr>
<td>T</td>
<td>⠓ ⠓</td>
<td>*</td>
<td>⠓ ⠓</td>
</tr>
</tbody>
</table>
Webel Mediatronics Limited
P-1, Taratala Road, Kolkata 700088
Ph: +91-33-24017699/5602
Fax: +91-33-24014081
Email: webelmedia@gmail.com, wml@vsnl.com
Visit us at: www.webelmediatronics.in, www.braille-aids.in
CONTENTS

1. INTRODUCTION
2. SYSTEM SPECIFICATION
3. FEATURES
4. INSTALLATION
5. OPERATION
   TEXT ENTRY
   TRANSCRIPTION
   PREVIEWING
   PRINTING
   PAGE SETUP
   EXIT
6. MESSAGES
   APPENDIX A & B
   APPENDIX C
1. INTRODUCTION

Braille system is the only means of imparting effective training to the visually impaired persons. Manual Braille printing, though used for long time, is very slow and operator dependent. With advancement of technology it became an absolute necessity to automate the process of Braille printing.

TextBraille is user-friendly Braille Transcription software for Indian languages for windows. The software converts the text files to the Braille format, shows the text file as well as the Braille file side by side. As regards the printer interface, Modified Perkins Brailler & Index Interpoint Brailler is covered.

2. System Specification

Hardware Requirement:

- **Processor**: Pentium III with 733 or higher clock speed (Original INTEL Mother Board)
- **Memory**: 128 KB Cache memory 64 MB RAM
- **Hard Disk**: 20 GB hard disk drive (higher)
- **Keyboard**: 104 (or higher key) key keyboard
- **Port**: 2 Serial ports, 1 parallel port
Mouse : PS/2 Mouse with mouse pad and driver software

Multimedia : 52X (or higher) CDROM drive
             Dual Multimedia speaker

Monitor : 14 inch color monitor (256 color SVGA (min) or higher version)

Braille Embosser: Modified Perkins Braille printer (BPRT –10) or Index Interpoint Brailler along-with serial Interface cable

Software requirement:
i) Operating System should be Windows XP

ii) CDAC iLEAP word processor for creating Indian language document (ISCI file) but this software is not required to create Unicode file.

iii) GIST Redistribution Kit - CDAC

3. Salient Features of Text Braille

1. The Software is menu driven and user friendly.

2. It has a self explanatory GUI, and can be operated by any regular computer user with minimum knowledge of Braille.

3. The software converts the text files entered through Unicode into the corresponding Braille instantly. It also supports files exported from i-Leap.

4. The transcribed Braille file can be previewed in the screen along with the text maintaining a correlation between the two, which makes the system more user-friendly. The Unicode is supported for Bengali & Hindi only till now. For other languages i-Leap software is required.
5. **The transcribed Braille file can be saved (in any folder) in the hard disk** in Braille format and can be **edited** whenever required.

6. **The Braille files can be opened bypassing the text file.** So if the transcribed file is once generated can be printed/viewed that makes the operation easier.

7. User can select no. of lines per page and no. of characters per line and embossing will be reflected accordingly.

8. The downloaded English file and any email document can be embossed using this software.

9. The software presently support the following Indian languages:

   Assamese, Bengali, Devnagari, Gujrati, Kannada, Malayalam, Marathi, Oriya, Punjabi, Tamil, Telugu.

**4. Installation:**

Run the setup.exe from the CD / DVD drive. The program will be loaded in the Program files folder in the drive in which the operating system is loaded. Default folder `c:\Program Files\wmTextBraille` folder. The user will get some demonstration files in the software folder. Run the program from start → All Programs → wmlTextBraille.

**5. Operation**

The software is user friendly and completely Menu driven. Minimum knowledge of Braille is required to operate this software.

The first line is the Title Bar and shows the name of the software at the leftmost corner position and Max/Min Button at the right hand corner.

In the next line there is a Menu Item ‘File’ when this item is clicked with the left mouse button a drop down menu appears for selection of operation. The detail of operation is described below.
**File:** The user can select any one function. 1) Select 2) close 3) save 4) four recent files 5) exit.

**Select:** The user can select the Unicode files, .aci files or .brli files or all files. If the user opens .aci file then the transcribe window will appear automatically. If the user selects the .txt files in English then English grade 1 option is selected. If the user selects the .brli file then the Braille preview will appear on the monitor with its default page setup settings.

**Close:** The current file is closed. The user can now open another file.

**Save:** This menu is activated only when the user chooses the edit menu. After editing the file in expanded mode save the Braille file as filename_edit.brli in the destination folder.

**Recent files:** The user can open the recent four files as displayed on the screen.

**Exit:** The user exits from the application.

**View:** The next menu is View. If the user clicks on view then a dropdown menu appears which has two parameters i.e. tool bar and the status bar.

**Tool bar:** There is four tool bars just below the menu bar. They are select, transcribe, save & Braille print.

**Status bar:** The parameters are time, date, language selected, Braille page no., type selected during transcription.
**Windows:** There are three options text, Braille, tile. In the text mode only the .aci file will appear on the monitor. In Braille mode the .brli file will appear on the monitor. In tile mode both the text & Braille preview will appear on the monitor side by side.

**Braille:** The menu has two functions. 1) Emboss 2) transcribe

If the user selects transcribe then the transcribe window will appear, if the user wants to print the Braille file then select emboss.

**Create Text Files for Transcription**

Text Braille software accepts text files in 11 Indian Languages (at present)

Supported file formats are **.aci for Indian Languages.** First type the content using iLeap then export the file using export command to .aci format where all header portions are eliminated. Save the .aci file in any folder. The transcribed file will be saved in the same folder or in any existing/new folder. For maintaining reference always save the .aci file in the same folder where .lp2 files are saved having the same filename. If there is any changes required in the text file then edit the .lp2 file only, save it & then export again. **Do not edit the .aci file.** For English files only the notepad files can be opened. Save the word document in text only mode & then transcribe it.

For help in entering text using the above-mentioned editors refer to their manual /online help.

**Transcribe a file**

Left click the Menu Item ‘File’ on the menu bar to get the drop down menu. Select the desired file by choosing the proper path. If the user selects the .aci file then the transcribe window will appear automatically. You can choose a different folder to store the transcribed file but it is suggested to choose the same folder. The page setup window is at the left side of the screen showing the default page setup format i.e. the number of
characters in a line is 36 and the number of lines in a page is 25. If the user wants to change the page setup information then he must change it before transcription of each time. Select the language from Language option. Select the transcription format from 3 options (prose, poetry in prose format, poetry in verse format.)

After transcription is finished the preview window appears in the monitor. The window is divided into two halve, Braille and text. In Braille preview the 1st Braille page is viewed in normal mode with specified page setup settings. The top right corner specifies the Braille page number. The horizontal & vertical scrollbars are present to view the complete page. The next key shows the Braille pages one after another. The status bar gives the complete information of the selected file. If the user selects the Braille Preview mode then the preview starts from the start in expanded mode.

The left window shows the text file. The horizontal & vertical scrollbar are present to view the text window. The text related to each Braille page is displayed in the text window. The next key changes both the Braille & text preview synchronously. The user can also select one window at a time.

**Edit mode:** the Braille preview can be edited. For that first open the text file, transcribe it in Braille mode. Note down the corrections in the Braille file by viewing the Braille window. Then come to the starting page again in expanded mode. Choose edit preview – incorporate all the corrections in the complete Braille file and then press save command. The edited Braille file will be saved as filename_edit.brli file. Before editing always remember to make the Caps Lock key on. This file can be edited again & saved in the same filename. Follow the QWERTY table chart for entry in Braille font.

**Print a Transcribed File**

First select the Braille file that you want to print. Then select the print window. The page setup is already decided as soon as you transcribe the file. Select the embosser type & select the file by double-clicking the filename. Enter the starting page number and press ok. The data formatting starts for preview as well as print mode. After the formatting is complete the user can select the preview window or print mode.
Check whether the Braille printer connected to your computer is on line, Press any of the radio buttons all or selected according to your need to print the whole document or selected pages only. Choose the port selection. The Braille Printer can be connected to the Computer through Serial Port (COM 1 or COM 2 Port). Check that the paper is properly loaded in the Printer. Now select emboss. For modified Perkins Braille printer the printer takes the input line by line & printing starts spontaneously. Printing will start with the page setup as done in Page Setup Window and will continue to the end of page. When printing of this page is finished software will stop the printer for page changing. Load a fresh page in the printer (Refer to Printer manual for paper loading) and press ‘Continue’ button. Printing will again start in this page and in the same procedure will continue to the end of file. To terminate printing job prematurely press ‘Cancel’ button at any point of time. Pressing the ‘Cancel’ button will also close the Print Window. For index Basic D printer the complete print matter is stored in the temporary buffer and after scanning the complete file printing will start. Using index printer the user can take the Braille print in double sided pages thus reducing the page requirement.

Exit from the Software

To exit from the software either Left click the Menu Item ‘File’ on the menu bar to get the drop down menu. Select the ‘Exit’ menu option or press the ‘Window Close’ button at the top right corner of the application window. The software will close and control will return to Windows.

6. Messages

1. If the user does not choose any file then the message box comes ‘you must select a valid filename’.

2. The user must select the starting page number before formatting the file for printing. If not, the message box appears “enter the starting page no & press ok”

3. If the selected printer is not switched on or ready then message box appears ‘printer is not responding’
Appendix A

Rules to be obeyed during Text Entry in Indian Language for Braille conversion

Indian Language Text which is to be transcribed through text Braille is to be entered into Computer using the Indian Language Text Editor iLEAP /Leapoffice from CDAC. Text entered through the other Indian Language Text Editor (not from CDAC) may not be converted correctly.

**Paragraph rule for Indian Language Prose:**

To start a new paragraph from the next line of text the data entry operator should press <Enter> at the end of this line and should leave two spaces/a tab at the beginning of the next line. However if operator wants to leave one line blank between two paragraphs then he should <Enter> twice instead of once as stated earlier.

The same paragraph rule is also applicable for English.

**‘Lupta a’ (’) in Indian Language:**

During text entry in Indian Language if ‘Lupta a’ is typed as (’) single inverted comma then in the converted Braille page code for (’) will appear. If ‘Lupta a’ is typed as (,) comma without leaving a space after comma then the correct Braille code for ‘Lupta a’ will appear.

**Punctuation marks:**

While typing text for converting to Braille (whether it is English or Indian language) always place punctuation mark just after the entered text without leaving any space between text and punctuation mark and always leave a space just after punctuation mark and the following text. However for quotation mark always place opening quotation mark after leaving a blank space after the entered text and closing quotation mark just after the entered text and one space gap between quotation mark and the following text.

For example: What is your name? My name is X. This may be A, B, C.
Appendix B

**Braille Preview/Print**
The problem with Compact printing is that dividing a word at any point is not always acceptable. There are some specific conventions for breaking words depending on pronunciation syllable division etc. But dividing a word obeying all conventions etc is beyond our present scope. Hence text Braille have another Preview/Print format where the word when it can not be completely printed/previewed in this line is not broken but it is carried to the beginning of the next line as a whole leaving some blank spaces at the end of the current line.

This Preview/Print format is Braille Preview/Print.
# Braille Code Table For English

<table>
<thead>
<tr>
<th>Letter /Symbol</th>
<th>Braille Code</th>
<th>Letter /Symbol</th>
<th>Braille Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>U</td>
<td>B</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>W</td>
<td>D</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>Y</td>
<td>F</td>
<td>Z</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>.</td>
<td>H</td>
<td>,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>I</td>
<td>;</td>
</tr>
<tr>
<td>J</td>
<td>?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
METHOD TO EDIT A BRAILLE FILE:

If the user wants to edit a braille file then he must follow the table below for entering in braille. It is to be remembered that the user must type the corresponding alphabet with caps lock on and selecting the edit preview option in the wmltextbraille software

Edit table for text-braille software (with caps lock on)
<table>
<thead>
<tr>
<th>Character</th>
<th>ASCII Code</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td></td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td>&lt;</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td></td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td></td>
<td>V</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td></td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td></td>
<td>%</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td></td>
<td>{</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td></td>
<td>$</td>
<td></td>
</tr>
<tr>
<td>I</td>
<td></td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>J</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>K</td>
<td></td>
<td>!</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td></td>
<td>&amp;</td>
<td></td>
</tr>
<tr>
<td>M</td>
<td></td>
<td>;</td>
<td></td>
</tr>
<tr>
<td>N</td>
<td></td>
<td>:</td>
<td></td>
</tr>
<tr>
<td>O</td>
<td></td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>P</td>
<td></td>
<td>\</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td></td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>Z</td>
<td></td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>T</td>
<td></td>
<td>(</td>
<td></td>
</tr>
<tr>
<td>U</td>
<td></td>
<td>_</td>
<td></td>
</tr>
<tr>
<td>V</td>
<td></td>
<td>?</td>
<td></td>
</tr>
<tr>
<td>W</td>
<td></td>
<td>)</td>
<td></td>
</tr>
<tr>
<td>X</td>
<td></td>
<td>}</td>
<td></td>
</tr>
<tr>
<td>Y</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Z</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>#:</td>
<td>#</td>
<td>:</td>
</tr>
<tr>
<td>-----</td>
<td>----</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>&gt;</td>
<td>#:</td>
<td>Y</td>
<td>:</td>
</tr>
<tr>
<td>N</td>
<td>#:</td>
<td>)</td>
<td>:</td>
</tr>
<tr>
<td>T</td>
<td>#:</td>
<td>=</td>
<td>:</td>
</tr>
<tr>
<td>Q</td>
<td>#:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>,</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
USER MANUAL

ReadBraille 6.0
Software for reading text files using Tactile Reading devices

Webel Mediatronics Limited
P-1, Taratala Road, Kolkata 700088
Ph: +91-33-24017699/5602/0712/2282 3800
Fax: +91-33-24014081
Email: wml@vsnl.com, webelmedia@gmail.com
Visit us at: www.webelmediatronics.in, www.braille-aids.in
CONTENTS

Introduction
Features
System Requirements
  Specification of Compute
  Specification of Tactile Devices
  Specification of USB to Serial Converter HUB
  Component Check List

Installing ReadBraille 6.0
Running ReadBraille 6.0 for the first time
Tactile Reader
  Keyboard operation
  Tactile Connection
    Multi User Connection
    Single User Connection
  Tactile Device Operation
ReadBraille 6.0 Interface
  Individual Device Display
Operations
  Configuring Devices
  Resetting Devices
  Changing Assigned ports
  Getting Help
  Exit from Application
1.0 Introduction

Read Braille 6.0 is specially designed software for the visually impaired persons to read text files using Tactile Reader Devices developed by Webel Mediatronics Limited in English and 12 major Indian Languages.

Tactile Reader devices communicate with computer using serial communication. Upto 4 devices can be connected to the computer using any available USB to Serial converter communication devices. Devices can be configured to various types of files in various languages.

Software will display text as well as Braille separately for different devices. It will also interact with Tactile Reader navigating buttons. Visually impaired users can navigate to any desired portion of the file using these buttons.

The software described in this manual consists of an application for visually impaired persons to read text. This software can be used to set up e-Reading system for the Visually impaired persons. A sighted administrator will configure the Tactile devices and then no other assistance will be required for reading.

The Application will enable and empower visually impaired persons to read the text. The software runs on Windows 98, Windows 2000/XP.
2.0 Features

Read Braille 6.0 supports the following features:

- Operations through self-explanatory menu and buttons.
- It has a self-explanatory GUI, and can be operated by any regular computer user with minimum knowledge of Braille.
- Reading of text in English and 12 major Indian Languages.
- Any standard USB port to Serial port converter can be used.
- Any available Serial port can be assigned to any device by a sighted administrator.
- Sighted administrator will be able to configure different Tactile Reader devices using different serial communication ports with different files in different languages.
- Supports file types –
  - English – txt
  - Indian Languages – aci
  - Braille - brli, brlp, brf.
- Reading of file can be started from any desired location.
- Navigation through the text using Tactile Reader Device Buttons.
- In-built text to Braille transcription, English and Assamese, Bengali, Gujarati, Hindi, Kannada, Marathi, Malayalam, Oriya, Punjabi, Telugu, Tamil. 6-dot Braille standard is followed for transcription.
- Separate text and Braille display for separate devices.
- Different devices can be configured using different files in different languages.
- File name display for the current file being read.
- Page number and Line number display for the devices, which help a sighted person to know the current file position being read.
3.0 System Requirements

For installation of ReadBraille 6.0 Software following System is to be required.

3.1 Specification of Computer

Hardware

- Pentium IV Processor
- 128 MB RAM
- 20 GB Hard Disk
- 3.5"- 1.44 MB Floppy Disk Drive
- 52X CD ROM Drive
- 14" Color Monitor
- Keyboard
- Mouse
- Speaker
- Headphone

Operating System

- Windows 98, 2000, XP
3.2 Specification of Tactile Devices

Power Adapter

Input 160 to 230 V AC at 50 Hz.
Output 12 V DC, current operating 160 mA (Max 0.9 amp).

Tactile Device

• Number of Braille character is 20.

• Inputs
  ▪ 12 V DC through jack on the rear panel.
  ▪ In Multiple user modes, USB to Serial converter should be connected from computer and RS232 inlet through 9-pin D connector male to USB to Serial converter ports.

• DIP switch setting through the opening on Right Hand side panel.

• Output
  ▪ Braille feedback of 20 characters of Braille text.
  ▪ Audio feedback through earphone jack on the front panel. (23 mW) – for the key pressed
  ▪ Green Led for Power indication.
  ▪ RX/TX Bicolor Led indication for receiving/transmitting data.

• Mechanical dimensions
  ▪ Dimension: 32cm X 15 cm X 4cm.
  ▪ Weight: 600 gm.
3.3 Specification of USB to Serial Converter HUB

USB

- Compliance USB 1.1, 1.0, USB 2.0 backwards compatible
- Connector USB type B
- Speed Full speed 12 Mbps

SERIAL INTERFACE

- RS-232 Interface TxD, RxD, RTS, CTS, DTR, DSR, GND
- Connector Male DB9
- FIFO 128 bytes
- Serial line protection 15 KV ESD for all signals

SERIAL COMMUNICATION PARAMETERS

- Parity None, Even, Odd
- Data bits 7, 8
- Stop bit 1, 2
- Flow control RTS/CTS, XON/XOFF
- Speed 600 bps to 115.2 Kbps

POWER REQUIREMENTS

- Power Input 12 to 48 VDC (external) or 5 VDC (Bus power)
- Power Consumption BUS: 172 mA at 5 VDC, Ext. PWR: 117 mA at 12V
ENVIRONMENTAL

- Operating Temperature 0 to 55°C (32 to 131°F)
- Storage Temperature -20 to 85°C (-4 to 185°F)
- Operating Humidity 5 to 95% RH

3.4 Component Check List

Users are requested to check the components list before they go for the installation process. The components list includes:

<table>
<thead>
<tr>
<th>Name of the Components</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tactile device</td>
<td>1 to 4</td>
</tr>
<tr>
<td>Power supply module &amp; cable for the device</td>
<td>1 to 4</td>
</tr>
<tr>
<td>Headphone</td>
<td>1 to 4</td>
</tr>
<tr>
<td>USB to Serial Port Converter HUB</td>
<td>1</td>
</tr>
<tr>
<td>USB port connecting Data Cable (For Connection between HUB &amp; PC)</td>
<td>1</td>
</tr>
<tr>
<td>RS-232 serial Data Cable (For Connection between HUB &amp; Tactile Device)</td>
<td>1 to 4</td>
</tr>
</tbody>
</table>

Each cable is required for each Tactile device.

Instruction manual                                           | 1            |

**NB:** IF ANY OF THESE COMPONENTS ARE MISSING PLEASE CONTACT YOUR DISTRIBUTOR OR **Webel Mediatronics Limited.**
4.0 Installing ReadBraille 6.0

- Insert ReadBraille 6.0 CD into the CD Drive.

- Install Gist Redistribution kit if it is not already installed by double clicking on the setup icon.

- Open ReadBraille 6.0 SetUp folder.

- Find Setup.exe in the folder.

- Double Click on the Setup.exe icon to run the setup.

- Follow all the steps during the Installation process.
5.0 Running ReadBraille 6.0 for the first time

- Start> Programs> ReadBraille 6.0

- While running for the first time on a PC the software asks for a Liberation Key to activate. The following dialog will appear for the Liberation Key.

- A Registration key will be generated which unique for your PC. Inform the registration key to Webel Mediatronics Limited. WML will then send you the Liberation key.

- On entering the correct Liberation Key and clicking the Register button the software will be activated.

- Once activated, the software will not ask for any further activation in the same PC for subsequent runs. Even if the software is uninstalled from the PC, on installing again no activation key will be required.

- For availing the liberation key contact us.

- After registration process has been completed the following dialog will appear for the devices port assignment.
Device Port Assignment

- A sighted administrator have to configure the devices by assigning ports.

- After assignment of the ports to the devices users can configure the devices using files.

- Once the assignment has been done, the software will not ask for any further port assignment. However one can change the assigned ports any time.
6.0 Tactile Reader

Tactile Reader is an electronic Braille reading device developed by Webel Mediatronics Limited. TR provides 20 cell refreshable Braille display and a few control keys to read a Braille document line by line from a PC.

6.1 Keyboard operation

This tactile device has special function keyboard having twelve functional keys. Each key is associated with certain essential functions. The keys are of membrane type and gives tact felling with sound. For ease of identification for the blind user Braille embossing on the keys and provided. All keys pressing are supported by audio output though earphone.

- **LED** indicates the data reception/transmission is in progress.

- **LED** indicates the device is ON and ready for operation.

- **STOP** This command stops the current operation of the device i.e. reading of the current file.

- **END OF FILE** This command indicates the completion of the content of the file.

- **PREVIOUS BLOCK** A block is represented by 20 lines scroll so if a person wants to go to the previous 1 block or more than he can immediately jump to that location by pressing these block.

- **PREVIOUS LINE** Whenever we want to refer the previous line just before the current line that is in the output then we simply press this key and we can jump to that location.

- **START** This command starts the device for reading of text from the file.
• **START OF FILE** This command tells the user that the current text has been started and it is displayed on the o/p.

• **NEXT BLOCK** This command will change the current display by a block. A block can be defined by the user at 10, 20, 25, 30, 35. This facility saves time to move to a desired portion of the file.

• **NEXT LINE** the current display moves to the next line.

• **F1** Used for the diagnostic purpose.

• **F2** Used for the diagnostic purpose.

• **F3** Used for the diagnostic purpose.

• **F4** Used for the diagnostic purpose.

6.2 Tactile Connection

6.2.1 Multi User Connection
6.2.2 Single User Connection

6.3 Tactile Device Operation

- Ensure interconnection for single user & multiple users.

- Initially power supply switch for the SMPS should be kept OFF.

- Input power supply of 230 V AC, 50 Hz is fed to the SMPS power supply module, which converts it into 12 V DC. (Range of SMPS input voltages are 160V-230V AC).

- Now make the switch ON so that device can operate.

- After turning the switch ON all the Braille dots are initialized. Check whether all dots are in low position.
7.0 ReadBraille 6.0 Interface

View of ReadBraille 6.0 main Interface
7.1 Individual Device Display

File Name with path
Device Name
Select File Button

File Name: C:\Demo text for ReadBraille\English\CLOUDS.txt

Current Line:
Text View:
THE CLOUD

Braille View:

Current Position:
Block: 1 Line: 1

Reading Position
Text Display
Braille Display
Reset Button
8.0 Operations

8.1 Configuring Devices

- Run the software from Start > Program menu.

- After showing splash screen it will show the main interface screen. Go to the device portion which will be configured or open the menu of the desired device.

![Device Configuration Diagram]
• Click on the **Select File** Button or click on the **Device** menu as follows and click on the **Select File** Menu.

![Select File Menu](image)

Device configuration from Menu

• A Dialog will appear from which File Name, Location, File Type and Language can be chosen. It also has the option for setting start position for reading and lines per Block setting option.

![File choose dialog](image)
• Choose Language, File Type, Drive location, Folder location, File Name, Start Position and Lines per Block and press **OK** Button.

• If the device is configured properly then a message will be appeared confirming device configuration and will instruct how to start reading.

![Device configuration confirmation](image)

Device configuration confirmation

• If any error has been occurred during the device configuration error message will be displayed describing the type of the error.

• After device has been configured properly user can press device navigation buttons and read the text as desired.
8.2 Resetting Devices

- After configuring a device or while reading a file, user can reset the device to read another file.

- Click on the Reset button of the desired device portion or click on the **Reset Device** sub-menu of the **Device** menu. This will reset the device and close the communication between Device and the Computer.
Reset Device from Menu

- After closing the desired device configuration, follow the Device configuration steps to configure the device again.

8.3 Changing Assigned ports

- Click on the **Configure** menu.

- This will show the port configuration screen with current port names assigned to the devices.
• Click on the desired device portion and choose the port name as follows –

![Device and Port Configuration]

Changing Port Name of Device 1

OK Button

• Press on the OK button and a confirmation message will be displayed on the screen.
8.4 Getting Help

- Click on the **Help** menu and then click on the **ReadBraille 6.0 Help** submenu.

- It will open the desired help for operations on the software.

8.5 Exit from Application

- Close all the devices being run by clicking on the **Reset Button** or on the **Reset menu**. It will close the devices.

- Then click on the **exit** menu.

- If any error occurs, it will display corresponding error message.
<table>
<thead>
<tr>
<th>Letter /Symbol</th>
<th>Braille Code</th>
<th>Letter /Symbol</th>
<th>Braille Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>⠧ ⠧ ⠧</td>
<td>U</td>
<td>⠧</td>
</tr>
<tr>
<td>B</td>
<td>⠧ ⠧</td>
<td>V</td>
<td>⠧</td>
</tr>
<tr>
<td>C</td>
<td>⠧ ⠧ ⠧</td>
<td>W</td>
<td>⠧</td>
</tr>
<tr>
<td>D</td>
<td>⠧ ⠧ ⠧ ⠧</td>
<td>X</td>
<td>⠧ ⠧</td>
</tr>
<tr>
<td>E</td>
<td>⠧ ⠧ ⠧ ⠧</td>
<td>Y</td>
<td>⠧ ⠧</td>
</tr>
<tr>
<td>F</td>
<td>⠧ ⠧ ⠧ ⠧</td>
<td>Z</td>
<td>⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>G</td>
<td>⠧ ⠧ ⠧ ⠧</td>
<td></td>
<td>⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>H</td>
<td>⠧ ⠧ ⠧</td>
<td>,</td>
<td>⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>I</td>
<td>⠧ ⠧ ⠧ ⠧</td>
<td>;</td>
<td>⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>J</td>
<td>⠧ ⠧ ⠧ ⠧</td>
<td>?</td>
<td>⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>K</td>
<td>⠧ ⠧ ⠧</td>
<td>!</td>
<td>⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>L</td>
<td>⠧ ⠧ ⠧ ⠧</td>
<td>:</td>
<td>⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>M</td>
<td>⠧ ⠧ ⠧ ⠧</td>
<td>” “ “ ”</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>N</td>
<td>⠧ ⠧ ⠧</td>
<td>’ ’ ’ ’ ’ ’</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>O</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
<td>( )</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>P</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
<td>[ ]</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>Q</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
<td>-</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>R</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
<td>--</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>S</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
<td>----</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧ ⠧</td>
</tr>
<tr>
<td>T</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
<td>*</td>
<td>⠧ ⠧ ⠧ ⠧ ⠧</td>
</tr>
</tbody>
</table>
Operation Manual

WIMATS

Webel Mediatronics & ICEVI
MATHematics Transcription Software

International Council for Education of People with Visual Impairment

Webel Mediatronics Limited

WIMATS 1.0
Software for publishing Mathematics and Science Books in Braille
Founded in 1952, the International Council for Education of People with Visual Impairment (ICEVI) is a global association of individuals and organizations that promotes equal access to appropriate education for all visually impaired children and youth so they may achieve their full potential.

ICEVI believes that all children and youth with visual impairment have the same basic human rights as all other persons and should have access to:

- A full range of educational services of high standard conforming to best practices.
- Teachers and other professionals who are properly trained.
- Appropriate educational materials and methods to meet their needs.
- Parents and family members that understand their needs and support their education and.
- Access to an environment free of barriers, social stigmas and stereotypes.

That allows them to lead a productive life according to their aspirations and capabilities.

Webel Mediatronics Limited is a Govt. company based in Calcutta, India. WML is engaged in three different areas: studio & broadcasting electronics, Industrial Electronics and Information Technology for disabled.

WML has a research and development unit recognized by Department of Scientific and Industrial Research, Govt. Of India. The company has developed computerized Braille Transcription system in 13 major Indian languages, Electronic Braille display and e-learning system, special Braille keyboard and e-class room system etc. The system with different configuration has been installed at more than 110 Blind School all over the country.

WML has also developed application software; multimedia based teaching aids and electronic communication, aids for people affected with cerebral palsy and hearing impairment.
WIMATS1.0
Webel Mediatronics & ICEVI Mathematics Transcription Software

Operation Manual

ICEVI

*International Council for Education Of People with Visual Impairment*
3, Professors’ Colony,
Jothipuram, Coimbatore,
Tamil Nadu – 641 047, India
WIMATS Software License Agreement

Buying this package/software indicates your acceptance of these terms and conditions in the License Agreement. This product is provided by Webel Mediatronics Limited, India and International Council for Education of the People with Visual Impairment (WML and ICEVI), either directly or through its distributor and is licensed by WML and ICEVI only upon these terms and conditions. This is a legal agreement between the licensee and WML and ICEVI. WML and ICEVI reserve the right to take suitable legal action in case of any violation.

1. General
a) You acknowledge that:

i. The programs, associated document in print or electronic form contained in the package and underlying ideas, algorithms, concepts, procedures, processes, principals and methods of operation are confidential and contain trade secrets. User shall use its best efforts to maintain the confidentialities thereof.

ii. All intellectual property rights and the programs and document are owned by WML and ICEVI without limiting the generality of the preceding sentence, the programs, documents and user manuals are copyrighted and may not be copied except as specifically allowed by this license for backup purposes and to load the program on to the computer as part of executing the programs.

b) This license allows you to:
(i) Use the software and its associated data and/or information for your organization only on a single computer, for which it was designed;

(ii) Make copies of the software and its associated data and/or information in machine readable form, solely for backup purposes; and

(iii) Physically transfer the programs from one computer to another provided that the programs are used on only one computer at a time.

2. Restrictions

You may not market, distribute or transfer copies of the software and its associated data and/or information others outside your organization. The software and its associated data and/or information contain intellectual property and in order to protect them you may not decompile, reverse compile, reverse engineer, reverse translate, disassemble or otherwise reduce the software or it's associated data and/or information to a human readable form or distribute them to any third party. You may not modify, adapt, translate, rent, sell, give, lease or loan the software or its associated data and/or information or create derivative works based on the software, its associated data and/or information or the accompanying written materials.

3. Warranty

(i) WML and ICEVI warrants that the product will substantially confirm to the specifications provided that it is used on specified computer system and as per instruction. WML and ICEVI also warrant that the media on which the product is distributed is free from defects in materials and workmanship under normal use. WML and ICEVI will replace defective media or correct substantial Software error if returned within the warranty period.

(ii) The warranty does not cover any programs / product that have been altered or changed in any way by any one other than WML and ICEVI or the defect is due to accident abuse or misapplication by the licensee. WML AND ICEVI is not responsible for problems caused by changes in the operating characteristics of Computer Hardware or Computer operating systems nor for problems in the interaction of the Programs / product with non-WML and ICEVI Software.

4. Disclaimer

The foregoing limited warranty is in lieu of all other warranties of WML and ICEVI and WML and ICEVI disclaims all other warranties, expressed or implied, including the warranties of merchantability, fitness for a particular purpose, and non infringement of third party rights. No oral or written information or advice given by WML and ICEVI, its dealers, distributors, agents, employees, representatives or associates shall create a warranty or in any way increase the scope of this warranty unless agreed to in writing by WML AND ICEVI. Any such representatives will not bind WML and ICEVI. The licensee assumes entire risk as it applies to the quality and performance of the software and its associated data and/or information. Should the software and its associated
data and/or information prove defective, the licensee and not WML and ICEVI assume the entire cost of all necessary servicing repair or correction.

5. Limited Liability

In no event will WML and ICEVI or its distributors be liable for direct, indirect, special, incidental or consequential damages arising out of the use of or inability to use the product, even if advised of the possibility of such damages, specifically WML and ICEVI is not responsible for any costs including but not limited to those incurred as a result of lost profits or revenue, loss of use of the product, the loss of the data, the costs of recovering Software or data, the costs of substitute Software or data, claims by third parties or for other similar costs.

6. Support

i) The licensee will be put on the mailing list, for keeping them informed about the new products and applications.

ii) Queries will be accepted by Email/Fax from the licensees at the following address / number:

Webel Mediatronics Limited, P-1 Taratala Road, Kolkata – 700088, West Bengal, India, Tel: +91-33-24015602, Tel: +91-33-24010712

Fax: +91-33-24014081

E-Mail: webelmedia@gmail.com

iii) WML and ICEVI welcomes suggestions for the product improvement and problem removal. On its own discretion and basis of merit, it may give free copies of the Software incorporating these suggestions, to the licensee.

7. Governing Law

This agreement, including the limited warranty, the limited liability and the disclaimer of liability contained herein shall be governed by Indian laws. All disputes are subject to exclusive jurisdiction of courts in Kolkata. Nothing in the license constitutes a waiver of the rights of WML and ICEVI under the Copyright Law and other allied acts and statutes. You will be responsible for installation management and operation of the product.

8. You acknowledge that you have read this license agreement, understood it and agree to be bound by the terms and conditions. You further agree that this is the complete and exclusive statement of the agreement between us and it supersedes any proposal or prior agreement oral or written and any other communication between us relating to the subject matter of this license agreement.
For Software User Manual

This manual, as well as the Software described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by Webel Mediatronics Limited and International Council for Education of People with Visual Impairment. Webel Mediatronics Limited and International Council for Education of People with Visual Impairment assume no responsibility or liability for any errors or inaccuracies that may appear in this book. Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of Webel Mediatronics Limited and International Council for Education of the People with Visual Impairment.

All the trademarks are the property of their respective owners.

Written and designed at Webel Mediatronics Limited, P-1 Taratala Road, Kolkata - 700088, West Bengal, India
# Content

<table>
<thead>
<tr>
<th>Chapter No</th>
<th>Chapter</th>
<th>Page No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Introduction</td>
<td>6</td>
</tr>
<tr>
<td>2.0</td>
<td>Features</td>
<td>7</td>
</tr>
<tr>
<td>3.0</td>
<td>Installation</td>
<td>8</td>
</tr>
<tr>
<td>4.0</td>
<td>WIMATS Interface</td>
<td>9</td>
</tr>
<tr>
<td>5.0</td>
<td>Basic File Operations</td>
<td>19</td>
</tr>
<tr>
<td>6.0</td>
<td>Numerals</td>
<td>23</td>
</tr>
<tr>
<td>7.0</td>
<td>Basic Operators and Sings</td>
<td>26</td>
</tr>
<tr>
<td>8.0</td>
<td>Mathematical Brackets</td>
<td>30</td>
</tr>
<tr>
<td>9.0</td>
<td>Mathematical Sings and Shapes</td>
<td>32</td>
</tr>
<tr>
<td>10.0</td>
<td>Fractions</td>
<td>36</td>
</tr>
<tr>
<td>11.0</td>
<td>Geometric Shapes</td>
<td>41</td>
</tr>
<tr>
<td>12.0</td>
<td>Superscript and Subscript</td>
<td>45</td>
</tr>
<tr>
<td>13.0</td>
<td>Radicals and Index of Radicals</td>
<td>48</td>
</tr>
<tr>
<td>14.0</td>
<td>Sets</td>
<td>51</td>
</tr>
<tr>
<td>15.0</td>
<td>Trigonometry</td>
<td>53</td>
</tr>
<tr>
<td>16.0</td>
<td>Logarithms and Exponents</td>
<td>55</td>
</tr>
<tr>
<td>17.0</td>
<td>Arrows</td>
<td>57</td>
</tr>
<tr>
<td>18.0</td>
<td>Vectors</td>
<td>59</td>
</tr>
<tr>
<td>19.0</td>
<td>Greek Alphabet</td>
<td>61</td>
</tr>
<tr>
<td>20.0</td>
<td>Modified Shapes</td>
<td>63</td>
</tr>
<tr>
<td>21.0</td>
<td>Integration</td>
<td>65</td>
</tr>
<tr>
<td>22.0</td>
<td>Braille Conversion</td>
<td>68</td>
</tr>
<tr>
<td>23.0</td>
<td>Editing Braille File</td>
<td>70</td>
</tr>
<tr>
<td>24.0</td>
<td>Braille Embossing</td>
<td>71</td>
</tr>
<tr>
<td>25.0</td>
<td>Special Information</td>
<td>74</td>
</tr>
</tbody>
</table>
1.0 Introduction

WIMATS 1.0 is a software application for publishing Mathematics and Science books in Braille.

Using this software, teachers and transcribers can publish documents for Mathematics and Science subjects in Braille.

The software supports automatic conversion of Mathematical and Scientific texts to Nemeth codes along with English text. English text is converted into Braille following Grade -1 standard of Braille.

A user friendly editor for typing mathematical/ scientific texts is integrated with the software.

Converted Braille files can be embossed using Windows 2000/ XP compatible standard embossers such as Index Braille Embosser.

WIMATS software interface
2.0 Features

**WIMATS 1.0** supports the following features:

- Operations through self-explanatory menu, icon and space dialog boxes.

- The files can be saved, re-opened, edited by the user.

- The typed matter of the text file can be converted into Braille by single mouse click operation.

- English text can be converted to Grade-I Braille as per Literary Braille rules and Mathematical symbols to Braille codes as per Nemeth standard from the same file.

- The software automatically recognizes the text matter as English text or Mathematical symbols to do the conversion.

- The converted Braille codes are displayed in a different window. Both the Text and Braille windows can be displayed on the screen simultaneously if so selected by the user.

- 6-dot Braille standard is followed for transcription.

- The Mathematical Text file and the Braille file can be saved with different extensions (having different formats). In WIMATS Mathematical Text files are saved with `.wim` extension and Braille files are saved with `.wib` extension.

- The Braille file can also be edited in six key mode, saved and re-opened.

- Content of the Braille file can be embossed using Windows 2000/ XP compatible standard Braille Embossers connected to the PC.

- Text file can be printed through standard ink printers.

- Braille file is editable by typing in Braille using 6-keys only (SDF-JKL).
2.1 System Requirement

Hardware
Pentium III, 128 MB RAM, 20 GB HDD, CD ROM Drive, 15" Colour Monitor, 104 Key Keyboard, 2 Serial Port, 1 Parallel Port

Operating System
System Windows 2000, XP

3.0 Installation

• Insert the WIMATS 1.0 CD into the CD Drive.
• Open the WIMATS Setup folder.
• Find Setup.exe in the folder.
• Double Click on the Setup.exe icon to run the setup.

3.1 Running WIMATS for the first time

• Start> Programs> WIMATS1.0

• While running for the first time on a PC the software asks for a Liberation Key to activate. The following dialog will appear asking for the Liberation Key.

![Register Me! Dialog](image)
• On sending the Registration key to **Webel Mediatronics Limited** the Liberation key can be availed.

• On entering the correct liberation key and clicking the OK button the software will be activated.

• Once activated, the software will not ask for any further activation in the same PC for subsequent runs. Even if the software is uninstalled from the PC, on installing again no activation key will be required.

• For availing the liberation key, contact **Webel Mediatronics Limited** at: P-1, Taratala Road, Kolkata 700088, West Bengal, India Tel No.+91 33 2401 7699, +91 33 2401 5602, +91 33 2401 0712 or mail at: webelmedia@gmail.com

### 4.0 WIMATS Interface

![WIMATS Interface Diagram](image)

**View of WIMATS Interface**
# 4.1 Menu Bar

## File menu

<table>
<thead>
<tr>
<th>Sub-menus</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New</strong></td>
<td>Opens following sub-menus:</td>
</tr>
<tr>
<td><strong>New Text Document</strong></td>
<td>Creates a New <strong>Text</strong> Document.</td>
</tr>
<tr>
<td><strong>New Braille Document</strong></td>
<td>Creates a New <strong>Braille</strong> Document.</td>
</tr>
<tr>
<td><strong>Open</strong></td>
<td>Opens an existing Document.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Closes the active document.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the active document as same file name.</td>
</tr>
<tr>
<td><strong>Save As</strong></td>
<td>Saves the active document to a different file name.</td>
</tr>
<tr>
<td><strong>Export</strong></td>
<td>Exports the active Braille file in .brf format.</td>
</tr>
<tr>
<td><strong>Page Setup</strong></td>
<td>Opens following sub-menus:</td>
</tr>
<tr>
<td><strong>Text Document</strong></td>
<td>Configures the Page Setup of the active text document for print.</td>
</tr>
<tr>
<td><strong>Braille Document</strong></td>
<td>Configures the Page Setup of the active Braille document for Embossing.</td>
</tr>
<tr>
<td><strong>Print Preview</strong></td>
<td>Opens print preview window for previewing before print/emboss.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Prints the active text document in attached ink printer and embosses active Braille document in attached</td>
</tr>
<tr>
<td>Braille Embosser.</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Recent Files</strong></td>
<td></td>
</tr>
<tr>
<td>Displays a list containing last four opened files.</td>
<td></td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td></td>
</tr>
<tr>
<td>Exits from WIMATS to Windows.</td>
<td></td>
</tr>
</tbody>
</table>

### Edit menu

<table>
<thead>
<tr>
<th>Sub-menus</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undo</strong></td>
<td>Undo last editing.</td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Removes the selected text from the document and stores to clipboard.</td>
</tr>
<tr>
<td><strong>Paste</strong></td>
<td>Pastes the latest content of the clipboard.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Copies the selected text to clipboard.</td>
</tr>
<tr>
<td><strong>Select All</strong></td>
<td>Selects all text from the active document.</td>
</tr>
<tr>
<td><strong>Find</strong></td>
<td>Finds the defined text from the active document.</td>
</tr>
<tr>
<td><strong>Find Next</strong></td>
<td>Finds the next defined text from the active document.</td>
</tr>
<tr>
<td><strong>Replace</strong></td>
<td>Finds the defined text from the active document and replaces it by another text</td>
</tr>
<tr>
<td><strong>Color Black</strong></td>
<td>Changes the color of the text into black.</td>
</tr>
</tbody>
</table>
**View Menu**

<table>
<thead>
<tr>
<th>Sub-menus</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Toolbar</td>
<td>Shows or Hides the Standard Toolbar.</td>
</tr>
<tr>
<td>Operator Toolbar</td>
<td>Shows or Hides the Operator Toolbar.</td>
</tr>
<tr>
<td>Math Toolbar</td>
<td>Shows or Hides the Math Toolbar.</td>
</tr>
</tbody>
</table>

**Braille Menu**

<table>
<thead>
<tr>
<th>Sub-menu</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert</td>
<td>Converts the current active text document to Braille.</td>
</tr>
</tbody>
</table>

**Window Menu**

<table>
<thead>
<tr>
<th>Sub-menus</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td>Arranges the opened documents as cascade.</td>
</tr>
<tr>
<td>Tile</td>
<td>Arranges the opened documents as tile.</td>
</tr>
</tbody>
</table>

**Help Menu**

<table>
<thead>
<tr>
<th>Sub-menus</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>About WIMATS</td>
<td>Displays a dialog showing information about the application.</td>
</tr>
<tr>
<td>WIMATS Help</td>
<td>Opens WIMATS help</td>
</tr>
</tbody>
</table>
4.2 Standard Tool Bar

4.3 Operator Toolbar

4.4 Math Toolbar
### 1. Equations

- Plus or Minus
- Minus or Plus
- Varies as
- Factorial
- Ratio
- Proportion
- Mathematical Parenthesis Open
- Mathematical Parenthesis Close
- Mathematical Square Bracket Open
- Mathematical Square Bracket Close
- Mathematical Braces (curly bracket) Open
- Mathematical Braces (curly bracket) Close

### 2. Inequalities

- Not Greater than
- Not Less than
- Greater than or Equal To
- Less Than Equal To
- Is Congruent
- Equivalent
- Similar
- At Proximate
- Not Equal to
3. Fractions

- Opening Simple Fraction Indicator
- Closing Simple Fraction Indicator
- Simple Fraction Bar
- Opening Complex Fraction Indicator
- Closing Complex Fraction Indicator
- Complex Fraction Bar
- Opening Hyper Complex Fraction Indicator
- Closing Hyper Complex Fraction Indicator
- Hyper Complex Fraction Bar

4. Sets

- Membership
- Union
- Intersection
- Inclusion
- Reverse Inclusion
- Bar Under Inclusion Sign
- Bar Under Reverse Inclusion Sign
- Existential Qualifier
- Universal Quantifier
- Empty Set
- Empty Set Sign
5. Mathematical Signs

- Infinity
- Ditto Sign
- Ellipsis
- Therefore
- Since
- Implies
- Recurring Decimal

6. Arrows

- Left Pointing
- Right Pointing
- Upward
- Downward
- Horizontal Two Way
- Left Pointing Over Right Pointing
- Right Pointing Over Left Pointing
7. Upper Greek

- Alpha
- Beta
- Chi
- Delta
- Epsilon
- Phi
- Gamma
- Eta
- Iota
- Kappa
- Lambda
- Mu
- Nu
- Omicron
- Pi
- Theta
- Rho
- Sigma
- Tau
- Upsailon
- Omega
- Xi
- Psi
- Zeta
8. Lower Greek

<table>
<thead>
<tr>
<th>Lower Greek Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
</tr>
<tr>
<td>Beta</td>
</tr>
<tr>
<td>Chi</td>
</tr>
<tr>
<td>Delta</td>
</tr>
<tr>
<td>Epsilon</td>
</tr>
<tr>
<td>Phi</td>
</tr>
<tr>
<td>Gamma</td>
</tr>
<tr>
<td>Eta</td>
</tr>
<tr>
<td>Iota</td>
</tr>
<tr>
<td>Kappa</td>
</tr>
<tr>
<td>Lambda</td>
</tr>
<tr>
<td>Mu</td>
</tr>
</tbody>
</table>

9. Trigonometry

<table>
<thead>
<tr>
<th>Trigonometry Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sine</td>
</tr>
<tr>
<td>Cosine</td>
</tr>
<tr>
<td>Tangent</td>
</tr>
<tr>
<td>Cotangent</td>
</tr>
<tr>
<td>Secant</td>
</tr>
<tr>
<td>Cosecant</td>
</tr>
</tbody>
</table>
10. Integrals

- Single Integral
- Double Integral

11. Radicals

- Radical
- Opening Radical
- Closing Radical

12. Angles

- Angle (General)
- Right Angle
- Acute Angle
- Obtuse Angle
- Straight Angle
13. Modified Shapes

- Square with Interior Dot
- Square with Interior Diagonals
- Circle with Interior Dot
- Circle with Interior Cross
- Circle with Interior Plus Sign
- Circle with Interior Minus Sign
- Circle with Interior Arrow Pointing Right
- Circle with Interior Arrow Pointing Left
- Circle with Interior Arrow Pointing Up
- Circle with Interior Arrow Pointing Down

14. Logarithm

- Exponent
- Log Base e
- Log
- Log Base 2
- Log Base 10
15. Polygon
- Rectangle
- Parallelogram
- Rhombus
- Quadrilateral
- Regular Pentagon
- Regular Hexagon
- Irregular Pentagon
- Irregular Hexagon
- Star

16. Triangles
- Equilateral Triangle
- Isosceles Triangle
- Scalene Triangle
- Right Triangle
- Acute Triangle
- Obtuse Triangle
17. Geometrical Shapes

- Parallel to
- Not Parallel to
- Perpendicular to
- Not Perpendicular to
- Intersecting Lines
- Circle
- Ellipse

18. Vectors

- Both Side Pointing Up Arrow
- Left Pointing Up Arrow
- Right Pointing Up Arrow
- Upward Arc
- Downward Arc
5.0 Basic File Operations

5.1 File formats in WIMATS

WIMATS supports two types of files for editing. Extensions of these files are:

1. **wim**, and
2. **wib**

**wim** files can be taken as text files. Files with extension **wim** are for text entry and text editing in WIMATS.

**wib** are Braille files in WIMATS. Files with **wib** extension are converted Braille files. Also, the Braille files i.e **wib** files can be edited using six keys.

**Note:** **wim** (mathematical text) files can be converted to **wib** (Braille conversion) but **wib** files cannot be converted, as a **wib** file itself is a converted / created or edited Braille file and no further conversion is required.

![WIMATS software interface – wim and wib files](image)
5.2 Opening a new file

2 types of new files can be created.

1. wim - for typing mathematical expressions in text
2. wib - for typing mathematical expressions in Braille

Open a new wim file

Either click on the "create a new text document" icon on the standard tool bar.

Or click on the File> New > New Text Document menu

Open a new wib file

Either click on the "create a new Braille document" icon on the standard tool bar.

Or click on the File> New > New Braille Document menu
5.3 Opening an existing file for editing

To open an existing file for editing, click File > Open. The open dialog as following appears:

**Note:** When WIMATS is started the default document opened is wim.

To open an existing **text** file select **Text File** from the Files of Type list. All .wim types files in the selected directory will be displayed. Open the required one by selecting and subsequently clicking on open button.

To open a Braille file select **Braille File** from the Files of Type list. All .wib types files in the selected directory will be displayed. Open the required one by selecting and
subsequently clicking on open button.

5.4 Saving a file

To save a file click on File > Save. If the active file to be saved is a text file then the file is automatically saved with .wim extension and if the active file to save is a Braille file then .wib extension is given automatically.

To save an existing file with different name click on File > Save As.

5.5 Exporting a file in standard brf format of Duxbury

To export a .wib file in Duxbury brf format, click on File> Export.

The Export To Formatted Braille File dialog appears as following:

![WIMATS Export To Formatted Braille File dialog](image)

WIMATS Export To Formatted Braille File dialog

Save as type for the File is formatted Braille Files (.brf).

**Note:** Only .wib (Braille) files can be exported to .brf. If a .wim (text) file is the active one, the export sub-menu will remain disabled.

This facility has been provided for portability of a Braille document from WIMATS to other standard Braille conversion software applications.
6.0 Numerals

6.1. Typing Index Numbers

Type index as
(1)
(2)
(3)
etc.

Type numerals viz. 1, 2, 3 from keyboard.

Type the parentheses from Math Toolbar by clicking on the icon.

If typed from Math Toolbar the parentheses will appear in red colour.

Do not type brackets from keyboard. When typed from keyboard brackets are of literary type and gets converted in Braille as literary brackets.

Do not type index as
1.
2.
3.
etc. or,
1)
2)
3)
etc. or in any other form common in ink print.

6.2. Typing Numbers

Type numbers from keyboard.

For writing signed numbers as -3, type as "-" and 3.

Minus sign can be typed either from keyboard or from Operator Toolbar.
6.3. Mathematical Comma

For typing numeric expressions as 1,23,532
Type numerals from keyboard
Type Mathematical Comma from Operator toolbar.

Do not type comma in the above expression from the keyboard. When typed from the keyboard, the comma is treated as literary comma and get converted in Braille as literary comma.

For comma in a mathematical expression type Mathematical Comma from Operator Toolbar.

Note:
Do not insert space just after mathematical comma where it is being used as a numeric symbol.

Example:
1,478 ☐ ☐ ☐ ☐ ☐
(The mathematical comma is a numeric symbol in the above example, not a punctuation mark. Therefore do not insert space just after the mathematical comma.)

Insert a space after typing Mathematical Comma where the mathematical comma is being used as a punctuation mark.

Example:
100, 200, 300 ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐ ☐
(The mathematical commas are punctuation marks in the above example, not numeric symbols. Therefore insert space just after the mathematical commas.)
6.4. Decimal Point

Type expressions like 12.34 (Twelve point three four) as:

12 from keyboard
Decimal point from Operator Toolbar.

34 from keyboard
Do not type the dot of the period sign from keyboard as decimal point. That will be treated as period sign and will get converted in Braille as period sign.
7.0 Basic Operators and Signs

7.1. Plus
Type \( + \) (plus) sign either from keyboard or from Operator Toolbar.

7.2. Minus
Type \( - \) (minus) sign either from keyboard or from Operator Toolbar.

7.3. Multiplication
Cross Multiplication
Type \( \times \) (cross) multiplication sign from Operator Toolbar.

Type Ctrl + 8 (Num Lock on) from keyboard

Dot Multiplication Sign
Type \( \cdot \) (dot) multiplication sign from Operator Toolbar.
Type Ctrl + 9 (Num Lock on) from keyboard

7.4. Division

Type division sign from Operator Toolbar.

Note:
In Nemeth Braille no space is permissible between operators and operands.

i.e. 3 + 4 is written in Braille as 3+4

Therefore while typing in text, the expression three plus four is to be written as 3+4 without giving any spaces in between operators and operands.

WIMATS checks whether there is any space typed before or after plus, minus, cross or dot multiplication operator and division operator. Space is automatically curtailed if found in text before or after the operator while converting into Braille into Braille.

However, if space is required before or after any of these operators in Braille for some specific purpose, one extra space must be typed in order to get that.

For example, to write an expression like

is + 9

an extra space to be inserted before plus sign.

7.5. Equal to

Type = (is equal to) sign either from keyboard or from Operator Toolbar.
Type Ctrl + 6 (Num Lock on) from keyboard

**Note:** In Nemeth Braille spaces are required before and after Is Equal To sign. WIMATS inserts space before and after Is Equal To sign automatically.

### 7.6. Is Greater Than & Is Less Than

Type *Is Greater than* (>) and *Is Less than* (<) sign from keyboard.

**Note:**
In Nemeth Braille space is required before and after "Is Greater than" and "Is Less than" sign. WIMATS inserts space before and after these signs automatically.

### 7.7. Mathematical Comma

Type Ctrl + 4 (Num Lock on) from keyboard
Refer to 6.2

### 7.8. Degree

Type *degree* sign from Operator Toolbar.
Type Ctrl + 1 (Num Lock on) from keyboard

**Note:**
Write degree as *superscript*. 
For example, to write

\[ 30^\circ \]

- Type 30 from keyboard.
- Press `ctrl + shift + =`.
- The cursor will indicate superscript position.
- Now click on the degree sign from the Operator Toolbar (shown above).
- Press `ctrl + shift + =` for coming back to normal baseline position.

### 7.9. Omission Sign

Type omission (?) sign from **Operator Toolbar**. Omission sign is used in following type of expressions:

\[ ? + 16 = 20 \]
\[ 45 - 31 = ? \]

Type Ctrl + 2 (Num Lock on) from keyboard

### 7.10. Decimal Point

Type expressions like **12.34** (Twelve point three four) as:

Type 12 from keyboard

Insert Decimal point from Operator Toolbar (as shown above).

Type Ctrl + 3 (Num Lock on) from keyboard

### 7.11. Applications of Frequently Used Toolbar
Writing Basic Operators and Signs in WMATS

8.0 Mathematical Brackets

In Braille two types of brackets are used.

1. Literary Brackets
2. Mathematical Brackets

Type literary brackets from keyboards.

For Mathematical Bracket type from Equations group of Math Tool Bar. Click on the individual icons keeping the cursor at the proper position in the document where the character is to be inserted.
Mathematical Brackets in Math Tool Bar

- Parenthesis Open
- Parenthesis Close
- Square Bracket Open
- Square Bracket Close
- Braces Open
- Braces Close
Writing Mathematical Brackets in WIMATS

(1) \((a+b)(a-b)\)  (Parenthesis)
(2) \([a+[b+c]][a-(b+c)]\)  (Square Brackets)
(3) \{a+(b+c)}\{a-(b+c)}\)  (Braces)
9.0 Mathematical Signs and Shapes

Find commonly used mathematical signs and shapes under the following three groups of Math Tool Bar.

1. Equations
2. Inequalities
3. Mathematical Signs

Under these groups the following signs and shapes are there

1. Equations
2. Inequalities

- Not Greater than
- Not Less than
- Greater than Equal to
- Less than Equal to
- Is Congruent
- Equivalent
- Similar
- At Proximate
- Not Equal To

5. Mathematical Signs
To insert any Mathematical signs from the above groups into the document, place the cursor at the required position and click on the respective icon. The sign will get inserted.
Use of Signs under Mathematical Signs Group

1. $-\infty < x < +\infty$  (x lies between positive and negative infinity)
2. 3 units (Ditto sign)
3. $1+2+\ldots$ (Ellipsis)
4. $x=2$ (Therefore)
5. $x=0$ (Since)
6. $x>0$ (Implies that)
7. 12.3 (Recurring Decimal)
10.0 Fractions

Writing Fraction

Click on the Fraction button on the Math Tool Bar
The buttons under Fraction are:

10.1. Simple Fraction

To Write Simple fraction in the form

\[
\frac{2}{3}
\]

Click on the Fraction button on the Math Tool Bar
The buttons under Fraction are:
10.2.Mixed Fraction

To Write Mixed fraction in the form

\[
4 \frac{3}{8}
\]
- Type 4
- Click on the Fraction button on the Math Tool Bar
- Write the simple fraction part as above.

**Complex Fraction**

To Write Simple fraction in the form

\[
\frac{1}{\frac{2}{\frac{3}{4}}}
\]

Click on the Fraction button on the Math Tool Bar
The buttons under Fraction group for writing complex fraction are:
Write As:

- Click on the [ button (Complex Fraction Opening)
- Click on the ( button (Simple Fraction Opening)
- Then type numerator of the first simple fraction part i.e. 1
- Click on the / button (Simple Fraction Bar)
- Type the denominator i.e. 2
- Click on the ) button. (Simple Fraction Closing)
- Click on the / button in the second row (Complex Fraction Bar)
- Again click on the ( button (Simple Fraction Opening)
- Type numerator of the second simple fraction part i.e. 3
- Click on the / button (Simple Fraction Bar)
- Type the denominator i.e. 4
- Click on the ) button. (Simple Fraction Closing)
- Click on the ] button. (Complex Fraction Closing)
Hyper-Complex Fraction

To write hyper-complex fraction as:

\[
\frac{\frac{1}{4}}{\frac{3}{4}} \]

Write As:
- Click on the \{ button (Hyper Complex Fraction Opening)
- Click on the [ button (Complex Fraction Opening)
• Write 1
• Click on the ( button (Simple Fraction Opening)
• Write 1
• Click on the / button (Simple Fraction Bar)
• Write 4
• Click on the ) button. (Simple Fraction Closing)
• Click on the / button in the second row (Complex Fraction Bar)
• Write 1
• Again click on the ( button (Simple Fraction Opening)
• Type numerator of the second simple fraction part i.e. 3
• Click on the / button (Simple Fraction Bar)
• Click on the ] button (Hyper-complex Fraction Closing)
• Type the denominator i.e. 4
• Click on the ) button. (Simple Fraction Closing)
• Click on the ] button. (Complex Fraction Closing)
• Click on the / button on the third row (Hyper Complex Fraction Bar)
• Write 5
• Click on the } button (Hyper Complex Fraction Closing)

The fractions will appear as:
11.0 Geometric Shapes

Find commonly used geometrical shapes under the following three groups of Math Tool Bar.

1. Geometric Shapes
2. Angles
3. Triangles
4. Polygons

Groups containing various Geometrical Shapes under Math Tool Bar

Under these groups the following signs and shapes are there:

1. Geometrical Shapes
2. Angles

- Angle (General)
- Right Angle
- Acute Angle
- Obtuse Angle
- Straight Angle

3. Triangles

- Equilateral Triangle
- Isosceles Triangle
- Scalene Triangle
- Right Triangle
- Acute Triangle
- Obtuse Triangle

4. Polygon
To insert any Geometric Shape from above groups into the document, place the cursor at the required position and click on the respective icon. The shape will get inserted.
Note: A space is to be typed between the sign and the expression.

Polygons

(11) □ ABCD (Square ABCD)
(12) □ PQRS (Rectangle PQRS)
(13) □ ABCD (Parallelogram ABCD)
(14) ◊ ABCD (Rhombus ABCD)
(15) ◊ Q (Quadrilateral Q)
(16) ◊ H (Regular Hexagon H)
(17) ◊ P (Regular Pentagon P)
(18) *) S (Star S)
12.0 Superscript and Subscript

12.1 Superscript

Press Ctrl + Shift + = to change to Superscript mode and again press Ctrl + Shift + = for coming back to Normal mode.

As for example:

To write $a^2+b^2$

- Type $a$
- Holding Ctrl and Shift, Press = [Go to Superscript Mode]
- Type 2
- Holding Ctrl and Shift, Press = [Back to Normal Mode]
- Type +
- Type $b$
- Holding Ctrl and Shift, Press = [Go to Superscript Mode]
- Press 2
- Holding Ctrl and Shift, Press = [Back to Normal Mode]

12.2 Subscript

Press Ctrl + = to change to Subscript mode and again press Ctrl + = for coming back to
normal mode.

As for example:

To write $\text{H}_2\text{O}$

- Type $\text{H}$
- Holding $\text{Ctrl}$, Press $=$ [Go to Subscript Mode]
- Press 2
- Holding $\text{Ctrl}$, Press $=$ [Back to Normal Mode]
- Press ‘O’

Superscripts in WIMATS
Subscripts in WIMATS

(1) $X_i$
(2) $\beta X$
(3) $H_2O$
(4) Vitamin $B_{12}$
(5) $64_{10}$
13.0 Radical and Index of Radical

13.1 Radical

Find radical signs under the Radical group of Math Tool Bar.

Radical

- Radical
- Opening Radical
- Closing Radical

(i) To write expressions like the following form:

\[ \sqrt{a} \]

\[ \sqrt{225} \], etc.

Insert Radical Sign by clicking on the icon from Radical Group of Math Tool Bar. Then type ‘a’ or ‘225’.

(ii) To write expressions like the following form:

\[ \sqrt{x+y+z} \]

1. Insert Radical Open sign by clicking on the icon from Radical Group of Math Tool Bar.
2. Type the expression \( x+y+z \)
3. Then, insert Radical Close sign by clicking on the icon from Radical Group of Math Tool Bar at last of the expression.

(iii) To write expressions like the following form:

\[ \sqrt{x+\sqrt{x}} \] (i.e. the nested radicals)
1. Insert **Radical Open** sign by clicking on the icon from **Radical Group** of Math Tool Bar.
2. Type the expression \(x^+\)
3. Again, insert **Radical Open** sign (the 1\(^{st}\) Inner radical).
4. Type \(x\).
5. Then, insert **Radical Close** sign twice (closing the 1\(^{st}\) inner radical and outer radical subsequently) by clicking on the icon from Radical Group of Math Tool Bar at last of the expression.

**Note:** In WIMATS writing maximum 2 inner radicals are possible.

### 13.2. Index of Radical

Example:

\[\sqrt[p+q]{x + y}\]

To write:

- Insert 2 blank spaces before start writing.
- From keyboard, holding Ctrl, and Shift Press + [Go to Superscript Mode]
- Type \(p+q\). (The index part)
- From keyboard, holding Ctrl, and Shift Press + [Back to Normal Mode]
- Click on **Radical Open** from Radical Group of Math Tool Bar.
- Type \(x+y\)
- Click on **Radical Close** from Radical Group of Math Tool Bar.

**Note:** Insert 2 blank spaces before writing index. Otherwise while conversion to Braille the index part will be treated as a superscripted expression and will get converted in Braille as superscript.

Writing index inside radical is not possible in WIMATS.

If required to write, then some modification in the converted Braille file is to be done by the operator in six key Braille editing mode.
Radical
(1) $\sqrt{a}$
(2) $\sqrt{225}$

(3) $\sqrt{x+y+z}$
(4) $\sqrt{x+\sqrt{x}}$
(5) $\sqrt[3]{x+\sqrt[3]{y+\sqrt[3]{z+1}}}$

Index
(1) $p^q\sqrt{x+y}$
14.0 Sets

Find various notations used in writing set expressions under the Set group of Math Tool Bar.

Set group in Math Tool Bar of WIMATS

- Membership
- Union
- Intersection
- Inclusion
- Reverse Inclusion
- Bar Under Inclusion Sign
- Bar Under Reverse Inclusion Sign
- Existential Qualifier
- Universal Quantifier
- Empty Set
- Empty Set Sign

To insert any notation from above group into the document, place the cursor at the required position and click on the respective icon. The required sign will get inserted.
Sets in WIMATS

Note: Insert space between expression and signs.
15.0 Trigonometry

Find various trigonometric ratios under the Trigonometry group of Math Tool Bar.

Trigonometry

- Sine
- Cosine
- Tangent
- Cotangent
- Secant
- Cosecant

To insert any trigonometric ratio from above group into the document, place the cursor at the required position and click on the respective icon. The required trigonometric ratio will get inserted.
Trigonometric Expressions in WIMATS

Note: Insert space between name of the trigonometric ratios and values.
16.0 Logarithms and Exponents

Find logarithmic expressions under the **Logarithm** group of Math Tool Bar.

Logarithm

- Exponent
- Log Base e
- Log
- Log Base 2
- Log Base 10

To insert logarithmic expression from above group into the document, place the cursor at the required position and click on the respective icon. The expression will get inserted.
Logarithmic Expressions in WIMATS

Note: Insert space between name of the logarithmic expressions and values.
For example, to write $\log x$ with base $a$ (as in ex. 2 above), insert $\log$ from logarithm group of Math Tool Bar. Then write $a$ as subscript (pressing ctrl and +), insert a space and type $x$ thereafter.
17.0 Arrows

Find arrows under the Arrows group of Math Tool Bar.

Arrows

- Left Pointing
- Right Pointing
- Upward
- Downward
- Horizontal Two Way
- Left Pointing Over Right Pointing
- Right Pointing Over Left Pointing

To insert arrows from above group into the document, place the cursor at the required position and click on the respective icon. The arrow will get inserted.
**Arrows** in WIMATS

**Note:** Insert space between arrows and expressions
18.0 Vectors

Find vectors under the Vectors group of Math Tool Bar.

Vectors

- Both Side Pointing Up Arrow
- Left Pointing Up Arrow
- Right Pointing Up Arrow
- Upward Arc
- Downward Arc

To insert vectors from above group into the document, place the cursor at the required position and click on the respective icon. The vector will get inserted.

To write an expression like

\[ \vec{xy} \]

1. Write \( xy \).
2. Place the cursor after \( xy \).
3. Click on the Both Side Pointing Up Arrow from the Vectors group of Math Tool Bar.
4. \( \vec{xy} \) Sign will come over \( xy \).
Vectors in WIMATS
19.0 Greek Alphabet

Find Greek alphabets under the following groups of Math Tool Bar.

1. Upper Greek
2. Lower Greek

1. Upper Greek

- Alpha
- Beta
- Chi
- Delta
- Epsilon
- Phi
- Gamma
- Eta
- Nu
- Omicron
- Pi
- Theta
- Rho
- Sigma
- Tau
- Upsailon

![Upper Greek Group Diagram]

![Lower Greek Group Diagram]
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Iota</td>
<td>Omega</td>
</tr>
<tr>
<td>Kappa</td>
<td>Xi</td>
</tr>
<tr>
<td>Lambda</td>
<td>Psi</td>
</tr>
<tr>
<td>Mu</td>
<td>Zeta</td>
</tr>
</tbody>
</table>

### 2. Lower Greek

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Alpha</td>
<td>Nu</td>
</tr>
<tr>
<td>Beta</td>
<td>Omicron</td>
</tr>
<tr>
<td>Chi</td>
<td>Pi</td>
</tr>
<tr>
<td>Delta</td>
<td>Theta</td>
</tr>
<tr>
<td>Epsilon</td>
<td>Rho</td>
</tr>
<tr>
<td>Phi</td>
<td>Sigma</td>
</tr>
<tr>
<td>Gamma</td>
<td>Tau</td>
</tr>
<tr>
<td>Eta</td>
<td>Upsailon</td>
</tr>
<tr>
<td>Iota</td>
<td>Omega</td>
</tr>
<tr>
<td>Kappa</td>
<td>Xi</td>
</tr>
<tr>
<td>Lambda</td>
<td>Psi</td>
</tr>
<tr>
<td>Mu</td>
<td>Zeta</td>
</tr>
</tbody>
</table>

To insert Greek alphabets from the above groups into the document, place the cursor at the required position and click on the respective icon. The alphabet will get inserted.
Greek Alphabets in WIMATS

20.0 Modified Shapes

Find modified shapes under the Modified Shapes group of Math Tool Bar.

Modified Shapes
• Square with Interior Dot
• Square with Interior Diagonals
• Circle with Interior Dot
• Circle with Interior Cross
• Circle with Interior Plus Sign
• Circle with Interior Minus Sign
• Circle with Interior Arrow Pointing Right
• Circle with Interior Arrow Pointing Left
• Circle with Interior Arrow Pointing Up
• Circle with Interior Arrow Pointing Down

To insert modified shapes from the above group into the document, place the cursor at the required position and click on the respective icon. The modified shape will get inserted.
21.0 Integration

Find single and double integration signs under the **Integrals** group of Math Tool Bar.

To insert integration signs from the above group into the document, place the cursor at the required position and click on the respective icon. The integration sign will get inserted.
Examples:

(i) Writing single integral without limit as

\[ \int f(x) \, dx \]

1. Insert single integral sign by clicking on the single integral icon on the Integrals group of Math Tool Bar.
2. Type \( f \) from the keyboard.
3. Type mathematical parenthesis from the Equations group of Math Tool Bar.
4. Type \( x \) into the mathematical parenthesis.
5. Type \( d \) and \( x \) from the keyboard.
6. Do not insert any space between the characters.

(ii) Writing single integral with limit as

\[ \int_a^b f(x) \, dx \]

1. Insert single integral sign by clicking on the single integral icon from the Integrals group of Math Tool Bar.
2. Type \( a \) (the lower limit) as subscript. Note that the lower limit to be typed first as subscript.
3. Type \( b \) (the upper limit) as superscript. Note that the upper limit to be typed after the lower limit.
4. Type \( f \) from the keyboard.
5. Type mathematical parenthesis from the Equations group of Math Tool Bar.
6. Type \( x \) into the mathematical parenthesis.
7. Type \( d \) and \( x \) from the keyboard.
8. Do not insert any space between the characters.

(iii) Writing double integral as

\[ \iint_R f(x, y) \, dA \]
1. Insert double integral sign by clicking on the double integral icon from the Integrals group of Math Tool Bar.

2. Type R (the lower limit) as subscript.

3. Type f from the keyboard

4. Type mathematical parenthesis open from the Equations group of Math Tool Bar.

5. Type x from the keyboard into.

6. Type Mathematical Comma from the Operator bar.

7. Type y from the keyboard.

8. Type mathematical parenthesis close from the Equations group of Math Tool Bar.

9. Type d and A from the keyboard.

10. Do not insert any space between the characters.

Integrations in WIMATS
22.0 Braille Conversion

To convert the wim file (text file) to corresponding wib file (Braille file) click on the convert button from the Standard Tool Bar or click on Braille > Convert.
The active text file will be converted to Braille. The extension of the converted Braille file will be .wib.

**Note:** You cannot convert a wib file. When the wib file will be active the "Convert to Braille" button on the main tool bar and Braille> Convert menu will remain **inactive**. The wib file itself is a Braille file and can not be converted into Braille again.
23.0 Editing Braille File
After conversion of the Mathematics Text file a new Braille file will be generated on a separate window. You can save this file as .wib file.

This Braille file is editable, in case you require to change some characters or add some more Braille characters in the converted file.

For typing in Braille in a fresh file open a new wib file with File> New > New Braille Document.

While the wib (Braille file) is active the keyboard automatically changes into six keys mode. That is the keys mentioned in the following list will remain active and all other keys in the keyboard will remain inactive.

For data entry in Braille use the following six keys:

- S for dot 3
- D for dot 2
- F for dot 1
- J for dot 4
- K for dot 5
- L for dot 6

You will have to simultaneously press the keys to get the dot combination. For example, to type \( \ddot{a} \) (dot 1,2,3,5,6) press keys F, D, S, K and L simultaneously.

Also the following keys can be used for their normal operations:

1. Space Bar
2. Enter
3. Backspace
4. Arrow Keys (Left, Right, Up and Down)

**Note:** The editing in the converted Braille file will not be reflected in the corresponding text file.

### 24.0 Braille Embossing

Content of a wib (Braille file) can be embossed using **Windows 200/ XP compatible standard Braille Embossers** connected to the PC.

To emboss a Braille file:
1. Go to File> Page Setup> **Braille Document**

2. **Braille Page Setup dialog** will appear as following:

3. Set the **Line Per Page** and **Characters Per Line**.
Note:

The default Line Per Page is set to 29 and Characters Per Line to 39 (including spaces). Adjust these settings in accordance to match the type of the Embosser attached to your PC and paper size.

No. of lines per page includes the line of page number also. So for 29 lines per page of 27 Braille Lines and 1 line for displaying Page Number and 1 blank line between page number and 1st Braille line of the page, will appear.

If these settings is not fixed prior to embossing then the embossed Braille page will be fixed as per default setting i.e. 29 lines per page and 39 Braille characters (including spaces) per line.

5. For print preview click on the print preview button on the standard toolbar. Print preview for Embossing appears as following:

6. Before embossing save the file either .wib or .brf format
Go to File> Emboss or press ‘E’.

7. The **ibPrint2.2** Dialog appears as following:

![ibPrint2.2 Dialog](image)

8. First Add the **.wib** or **.brf** file and Select the Installed Embosser From the Name list of available printers. Here **Basic-D** is selected.

**Note:**

If a Windows compatible Embosser is installed on your PC the name of the Embosser will appear under the Name List of **ibPrint2.2** dialog.

9. Select the Print Range, No. of Copies etc and click OK.

10. Braille Embossing will be initiated.

In WIMATS user can also take the Ink print of text document easily

Press ‘Ctrl+P’ for printing
25.0 Special Information

The operator of WIMATS is expected to keep in mind the given information below for working with WIMATS in order to obtain correct results in the converted Braille document:
25.1 Inserting spaces before paragraph.

Insert 2 spaces and start typing from the 3rd cell while typing a new text paragraph in WIMATS.

25.2 Writing Digits as in English Braille

Arabic digits entered from the keyboard will always be converted in Braille as in the Nemeth code as following:

<table>
<thead>
<tr>
<th>Numeral</th>
<th>English Braille Code</th>
<th>Type in WIMATS as</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>\ldots3456\ldots345</td>
<td>#j</td>
</tr>
<tr>
<td>1</td>
<td>\ldots3456\ldots1</td>
<td>#a</td>
</tr>
<tr>
<td>2</td>
<td>\ldots3456\ldots24</td>
<td>#b</td>
</tr>
<tr>
<td>3</td>
<td>\ldots3456\ldots134</td>
<td>#c</td>
</tr>
<tr>
<td>4</td>
<td>\ldots3456\ldots1245</td>
<td>#d</td>
</tr>
<tr>
<td>5</td>
<td>\ldots3456\ldots125</td>
<td>#e</td>
</tr>
<tr>
<td>6</td>
<td>\ldots3456\ldots1234</td>
<td>#f</td>
</tr>
<tr>
<td>7</td>
<td>\ldots3456\ldots1345</td>
<td>#g</td>
</tr>
</tbody>
</table>

In some special cases, where conversion of Arabic digits are required as in English Braille (numerals on title page, for example) the numerals should be typed as following:
25.3 Decimal in the form of .34

Decimals in ink print like .34 should be typed in WIMATS as 0.34

25.4 Inner Quotation Mark and Apostrophe

In WIMATS if apostrophe is written with quotation marks Braille conversion will appear incorrectly.

Example, ‘1’s, 2’s and 3’s’

If writing this type of expression is required, the operator has to modify the converted Braille in the wib file using six key Braille editing mode.

25.5 Hyphen and Dash

Hyphen

Type “−” either from keyboard or from Operator Toolbar for 1 time.

Short Dash

Type “–” either from keyboard or from Operator Toolbar for 2 times.
Long Dash

Type “–” either from keyboard or from Operator Toolbar for 4 times.

*Insert preceding/ following spaces as required in the converted Braille document.*

25.6 English Letter Indicator

WIMATS does not insert English letter indicator in the converted Braille file automatically. Therefore, the operator has to type English letter indicator, as required, in the converted Braille file by six keys Braille editing.

25.7 Spatial Arrangement

Spatial arrangement of fraction, basic arithmetic operations, matrix, determinant etc. are not included in WIMATS. Mathematical expressions should be written in linear form.

25.8 Breaking long mathematical expression

If a long mathematical expression runs in more than one line the operator has to take care of breaking the line in appropriate position. The converted Braille file is to be modified by the operator by giving *enter* in the required position of the Braille line in the Braille document and inserting dot 5 at the end of the breaking line using six keys Braille editing.

Long Numerals

Long numerals that cannot be completely accommodated on one Braille line may be
divided and run over to another line. Such a division is made after a comma, if present and a hyphen must be supplied. The numeric indicator must be used as the first Braille symbol of the Braille line to which the numeral has been run over.

100,000,000,000, 000

This is to be done manually by the operator by breaking the line and inserting hyphen appropriately.

25.9 Running sequence of capital letters

WIMATS converts running sequence of capital letters as following:

For example, ABC is converted in Braille as,  

In case of geometric (Triangle ABC) or other expressions, where each letter in the sequence requires capitalization without in between space, WIMATS does not convert treating each capital letter separately in the sequence.

Therefore the operator has to modify the converted Braille expression in the wib file using six keys Braille editing mode as following:

25.10 Superscribed/ subscribed arrow and arc

\( xy \) in WIMATS will be converted as
It should be like

\[(\cdot\cdot)\]

The multipurpose indicator (\(\cdot\cdot\)) is not automatically inserted. The operator has to write the multipurpose indicator automatically in Braille document using six keys Braille editing mode.

25.11 Superscript more than one level

WIMATS does not allow writing superscript more than one level. For example, writing \(x^2\) to the power 2 to the power 2 is not possible. If required the operator has to write directly in Braille document using six keys Braille editing.

25.12 Punctuation after miscellaneous symbols

WIMATS does not insert punctuation indictor automatically when punctuation signs come just after the following miscellaneous symbols:

- General omission sign, \%, @, caret (circumflex), check mark, ditto mark, dollar sign, factorial, infinity, empty set, degree, universal qualifier, since, therefore

The operator has to type punctuation indicator in those cases in the Braille document by six keys editing.
25.13 Roman Numerals

Capitalized Roman Numerals can be written using following keys of the keyboard:

I
II
III
IV
V

Lower case Roman numerals cannot be written in WIMATS.

The WIMATS has been created in order to help a teacher to prepare Mathematical Text material without much difficulty.

As the text creation resemble normal text mode, mathematics teacher without knowledge in Braille may also be used for creating text.

The Braille production centers will find WIMATS useful for Braille book production work.

ICEVI and WML believe that this software will make a difference in Mathematics education for children with visual impairment.

This is the first edition of WIMATS and it will be updated periodically on the basis of feedback from the users.